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NetWitness Platform System Maintenance

This guide tells administrators how to manage hosts and services in the network, maintain and monitor
the network, run jobs, and tune performance after initial network setup.

The following diagram shows the different system maintenance tasks available to you.
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Best Practices

Safeguarding Assets with RSA Supplied Policies

The purpose of the RSA Core Policies delivered with NetWitness Platform are for safeguarding your
NetWitness Platform Domain assets immediately (before you configure rules specific to your
environment and your Security Policy).

RSA recommends that you set up email notifications to the appropriate asset owners for these policies as
soon as possible. This will notify them when performance and capacity thresholds are crossed so they
can take action immediately.

RSA also recommends that you evaluate the Core policies and disable a policy or change its
service/group assignments according to your specific monitoring requirements.

Safeguarding Assets with Policies Based on Your Environment

RSA Core Policies are generic and may not provide sufficient monitoring coverage for your environment.
RSA recommends that you gather issues over a period of time, not identified by the RSA Core
Policies, and configure rules to help you prevent these issues.

Creating Rules and Notifications Judiciously

RSA recommends that you make sure that each rule and policy is necessary before you implement it, if
possible. RSA also recommends that you review implemented policies or a regular basis for their
validity. Invalid alarms and email notifications can adversely affect the focus of the asset owners.

Troubleshooting Issues

RSA recommends that you review Troubleshooting Health & Wellness and Troubleshoot NetWitness
Platform when you receive error messages in the user interface and log files from hosts and services.

Best Practices 8
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Monitoring Health and Wellness of NetWitness

Platform

The Health & Wellness module of NetWitness Platform provides the ability to:

o View the current health of all the hosts, services running on the hosts, and various aspects of the
hosts’ health.

o Monitor the hosts and services in your network environment.
o View details of various event sources configured with NetWitness Platform.

View system stats for the selected hosts by filtering the views as required.

In addition, you can configure Archiver monitoring and Warehouse Connector monitoring, use the
procedures on monitoring host statistics, and work with system logs to monitor NetWitness Platform.

Note: All users have permission to view the entire Health and Wellness interface by default. The
Administrator and the Operator roles are the only roles that can manage the Policies view by default.
Please refer to the "Role Permissions" topic in the Security User Management Guide for a complete
list of the default permissions for the NetWitness Platform Interface.

The figure displays the Health & Wellness module of the NetWitness Platform user interface and
various sections in the Health & Wellness module.

RSA RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN 2 @Dadmno (@)

Hosts  Services Event Sources Health & Wellness  System  Security

PAELLEI Monitoring  Policies  System Stats Browser  Event Source Monitoring  Settings
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[} @ Hizh  Concentrator Aggregation Behind 1M Sessions  Cancentrater SIT-ENDPOINTSERVER Sessions Behind 10.31.125.37:5000: 3728314903 =
] @ Hizh  Concentrator Not Consuming From Service Cancentrater SIT-ENDPOINTSERVER
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[} @ Hish  Concentrator Aggregation Behind >M Sessions  Concentrater SIT.LOGHYERID]
[} @ Hish  Warehouse Connector Stream Behind Warehouse Connector  SIT-DECODERT
[} ® Hig High Sysc p Utilization Host SIT-LOG-HYBRID1
[} ® HiZ High Sysc p Utilization Host SIT-PACKET-CONC
[} ® Hig Concentrator Aggregation Behind >1M Sessions  Concentrater SIT-LOG-HYBRID1
m] @H Host SIT-LOG-HYBRID1 Mounted Filesystem Disk Usage Perc...
a @ H Host Info/Swap Utlization
a @ H Host
a @ H Concentrator
] ® Hig Mac agent count Endpoinc Server SIT-ENDPOINTSERVER
] ® Hig Broker Custom Rule Broker SIT-BROKER Broker/Status
L Y - Dol Fimen DI Ot CIT LAAL W ADE [P T

| Page 1 of7 | } D ||C © autoRefresh Items 1-50 of 308
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Manage Policies

Policies are either user-defined or supplied by RSA. A policy defines:
o Services and hosts to which the policy applies.

o Rules that specify statistical thresholds that govern alarms.

o When to suppress the policy.

o Who to notify when an alarm triggers and when to notify them.

For the related reference topics, see NetWitness Platform Out-of-the-Box Policies

Note: You can now configure a policy to notify Public Key Infrastructure (PKI) certificate expiration
status.

Add a Policy

1. Goto ADMIN > Health & Wellness.
2. Click Policies tab.

The Policies view is displayed.

3. Click +- in the Policies panel.

A list of your hosts and services displays for which you can create health policies.

Monitoring Health and Wellness of NetWitness Platform
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Alarms Monitoring

Policies

+ - | h2e
Admin Server
Archiver
Broker

Cloud Gateway Server
Concentrator

Config Server
Content Server
Contexthub Server
Correlation Server
Decoder

Endpoint 5erver
Entity Behavior Analytics
Event Stream Analysis
Host

Integration Server
Investigate Server
Log Collector

Log Decoder
Malware Analysis
Orchestration Server
Reporting Engine
Respond Server
Security Server
Source Server

UEBA Server

Warehouse Connector

d Workbench

Policies

-

4. Select a host or service (for example, Concentrator).
For PKI policy, you must select a host (for example, Host).

11
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The host or service is displayed in the Policies panel with a blank Policy Detail panel.

Policies
+o -1 ® X
b O] Archiver
b [ Broker

4 & Concentrator

@00

@ 5A Concentracor Monitoring Policy
“|]

5. Enter a name for the Policy (for example, Concentrator Policy Status) in the Policies panel.

Policies
+o =21 ® X
b CJ Archiver
» [JEroker

© 00O

4 & Concentrator

@ 5A Concentrator Monitoring Policy

O|Concentrator Policy Status|

The name (for example, Concentrator Policy Status) is now displayed as the policy name in Policy
Detail panel.

6. Create a Policy in the Policy Detail panel:
a. Select the Enable checkbox.

b. Add relevant services (in this example, any relevant Concentrator services) that you want to
monitor for health statistics.

For PKI policy, you must select the LOCALHOST to monitor for health statistics.
c. Add relevant rule conditions you want to configure for the policy.
d. Suppress enforcement of the policy for the time periods you want.
e. Add any email notifications you want for the policy.
f. Click Save in the Policy Detail panel.
The Policy is added.

Monitoring Health and Wellness of NetWitness Platform 12
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Add Policy Example

Below is the high-level example for configuring PKI policy:
1. Add a new PKI policy.

RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN (@ admin @

Health & Wellness

Alarms  Monitoring [CBIISIENE  System Stats Browser  Event Source Monitoring  Settings

Policies Host: SA PKI

4o =Z | B2 ™ Enable Last Modified: 2016-05-04.03:51:14 PM
b O Archiver ©  Hosts
» CIBroker @  Choosethe hosts, services, and groups that your health policy applies to
» (I Concentrator o +-
» [CJContext Hub © U Name~ Group Type
» CJDecoder @ O Locaost Host
» ClEvent sed Analysis o
4 S Host 2]

he conditions under which you want to trigger an alarm for the NetWitness Platform health problems (definition includes
the alarm rule, enable or disable the alarm.

tatistic the alarm applies to, threshold, 3 at which the alarm clears). After you define

SA PKI + -

» CJ1PDE Extractor © ™ Enabie Name~ Severity Category Statistic Threshold
» (Jincident Management o ¥ Alert When a CRL Expi... Critical PKI SA Server PKI CRL Expiration Alarm <= 0 for 0 MINUTES
» [(Log Collector o

Policy Suppression
» [Log Decoder o

Define the time periods to suppress policies,
» CIMalware Analysis o

+ Time Zone:  UTC (GMT+00:00) v
» [JReporting Engine o

(=] = TR
» [JWarehouse Cannectar o

Click on + to add suppression to policy

» CIWerkbench ()

Notification

2. Add a Rule with Statistics:

o For CA Expiration

Add Rule

Enable ™
Mame Trusted CA Certificate Expiry Time
Description

High v
Pl ~ | | SA Server PKI Certificate Expiration ~ | | TRUSTED_CA ~
<= w2400 For 0 | Minutes
= v | 2400 For Minutes
+ Time Zone: UTC {GMT+00:00)

Ll pays T

Click on + to add suppression to rule

Cancel Save

« For CRL Expiration

13 Monitoring Health and Wellness of NetWitness Platform
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Add Rule

Enable ~
Name CRL Expiration Based On Time
Description

High v
PKI ~ | | S5A Server PKI CRL Expiration hd

= ~ 2400 For 0 £ Minutes

W
<

For 1 < Minutes L\\:

Time Zone: UTC (GMT+00:00)

Click on + to add suppression to rule

Cancel Save

« For CRL Status

Add Rule

4

CRL 5tatus
Description
Severity High v

~ | |5A Server PKI CRL Status hd

~  Valid For |0 £ Minutes

~  Valid For |1 £ Minutes

Time Zone: UTC {GMT+00:00)

Click on + to add suppression to rule

Cancel Save

« For Server Certificate Expiration

Monitoring Health and Wellness of NetWitness Platform 14
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Add Rule

Enable “
r%me |Sewer|Cer‘ti"'cate Expiry Time |
Description
Severity High e
~ | | SA Server PKI Certificate Expiration ~ | |SERVER_CERT ~
v || 2400 For |0 | Minutes
w2400 For 1 < Minutes

Time Zone: UTC {GMT+00:00)

Click on + to add suppression to rule

Cancel Save

Edit a Policy

1. Goto ADMIN > Health & Wellness.

2. Click the Policies tab.
The Policies view is displayed.

3. Select a policy (for example, Concentrator Policy Status) under a host or service.
The Policy Detail is displayed.

4. Click 4,

The policy name (for example, Admin Server Monitoring Policy) and policy detail panel become
editable.

15 Monitoring Health and Wellness of NetWitness Platform
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RSA RESPOND INVESTIGATE MONITOR  CONFIGURE ADMIN

Health Iness

Alarms  Monitoring VGG System Stats Browser Event Source Monitoring  Settings

c A ar : o ;
Policies Admin Server: Admin Server Monitoring Policy Save
+ Z | 1:’ :: Rules and suppression schedules of Qut-of-the-box policies cannot be directly modified. Duplicate the policy if you wish to so modify them
¥ Enable Last Modified: 2017-02-20 12:00:00 AM
43 Admin Server (1]
Admin Server Monitoring Policy Services
¥ Dl Avchiver [ Cheose the hosts, services, and groups that your health policy applies to
0 +
¥ [ Concentrator o Name ~ Group i
» [ Config Server ) . 16 -
3 Conesthub Server (1]
Rules
o Define the condit 0 trigger an alarm for the Netwitness Platform health problems (definition includes severity, statistic the alarm applies to, threshold, and threshold at which the alarm clears). After you define
Py the alarm rule. en
0
Enable  Name ~ Severi Categor Statistic Threshold
[T Host (1] ) Y -
Admin Server in Crid..  Critica Overall Proc, cator
¥ [J Investigate Server (1]
Admin Serv gh cator INUTES
¥ [T Log Collector 0
Admin Server Stapped  Critic
¥ [ Log Decoder [ I M

R SA NETWITNESS' PLATFORM

Make the required changes and click Save in the Policy Detail panel. You can:
« Edit the Policy name.

o Enable or disable the policy.

o Add or delete hosts and services in the policy.

o Add, delete or modify rules in the policy.

o Add/Edit/Delete suppressions in the policy.

o Add/Edit/Delete notifications in the policy.

Note: Save applies the policy rules based on the selection of enable/disable. It also resets the rule
condition timers for changed rules, and the entire Policy.

Duplicate a Policy

Go to ADMIN > Health & Wellness.
Click the Policies tab.

Select a policy (for example, Concentrator Policy Status) under a host or service.

Click = .NetWitness Platform copies the policy and lists it with (1) appended to the original policy's

Monitoring Health and Wellness of NetWitness Platform 16
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name.

RSA RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN

Health & We

Aarms  Monitoring VW= System Stats Browser  Event Source Monitoring  Settings

Policies Decoder: Decoder Monitoring Policy [ soe |
+ FIB% Rules and suppression schedul he-box policies cannot be directly modified. Duplicate the policy if you wish to so modify them
¥ Enable Last Modifiec: 2017-01-20 12:00:00 AM
» [] Admin Server (1]
»Darchier ©  Services
» [ 8rcker 0 Choose the hosts, services, and groups that your health policy applies to.
¥ L3 Concentrator (1] +
¥ (3 Contig Server (] Nome Group Type
Al Group
¥ [ Contexthub Server o
45 Decoder
e O pues
Decoder Monitoring Policy der which you var alarm for the NetWitness Suite health prablems (definition includes severity, statistic the slarm applies to, threshold, and threshold at which the alarm dlears),
fine the alarm rule, enable or
0
Enable Name ~ Severity Catego Statistic
»[IH o y gory
Capture Caprure Status
» [ Investigate Server (1]
cket R

» (] Log Collecror 0
¥ [JLog Decoder n- Ammten e - S — Mlaemm e A5 e VNI TEE v

RS /\ NETWITNESS® PLATFORM

5. Click 4 and rename the Policy [for example, rename Decoder Monitoring Policy(1) to New

Concentrator Policy Status.

Note: A duplicated policy is disabled by default and the host and service assignments are not
duplicated. Assign any relevant hosts and services to the duplicated policy before you use it
to monitor health and wellness of the NetWitness Platform infrastructure.

Assign Services or Groups

To assign hosts or services to a policy:

1. Goto ADMIN > Health & Wellness.

2. Click the Policies tab.
The Policies view is displayed.

3. Select a policy (for example, First Policy) under a host or service.
The Policy Detail is displayed.

4. Click + in the Services and Groups list toolbar.

17 Monitoring Health and Wellness of NetWitness Platform
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5. Choose one of the following actions:
o For Hosts, select Groups or Hosts from the selection menu.
o For Services, select Groups or Services from the selection menu.

6. Depending on whether you are assigning services or groups, perform one of the following actions:

o Groups, the Groups dialog is displayed from which you can select predefined groups of hosts or

services.
Add Groups
Groups Services
Mame Filter b4
0 & Name Host Type
Concentratar MWWAPPLIAMCEZ2655 Concentratar

Cancel Select

Monitoring Health and Wellness of NetWitness Platform 18
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« Services, the Services dialog is displayed from which you can select individual services.

Add Service
Groups Services
Mame Filter
= Name Host Type
[l Concentrator MWAPPLIANCEZ22655 Concentrator

the dialog, and click Save in the Policy Detail panel.

-

Cancel Select

7. Select the checkbox next to the groups or services you want to assign to the policy, click Select in

Note: Services are filtered for selection based on the type of policies. For example, you can only
select concentrator services for a concentrator type policy.

Remove Services or Groups
To remove a host or service from a policy:
1. Goto ADMIN > Health & Wellness.
2. Click Policies tab.

The Policies view is displayed.
3. Select a policy under a service.

The Policy Detail is displayed.

4. Select a host or service.

5. Click ~— .

The host or service is removed from the policy.

19 Monitoring Health and Wellness of NetWitness Platform
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Add or Edit a Rule

To add a rule to a policy:

1.
2.

Go to ADMIN > Health & Wellness.

Click the Policies tab.

The Policies view is displayed.

Select a policy (for example, Checkpoint) under a host or service.

The Policy Detail is displayed.

Depending on whether you are adding an existing rule or adding a rule, do the following:

o To add: click + in the Rules list toolbar.
« To edit: select a rule from the Rules list and click 4.
Complete the dialog to define or update the rule.

Add the Description field as shown in the following example.

Add Rule

Enable “ -
Name Check Point
Description Trigger alarm when Check Point Log Collection stops
severity Medium e
Checkpoint Collection v | Collection State ~
= v |stopped For |1 | Minutes
= ~ | started For 1 < Minutes

Time Zone: UTC (GMT+00:00)

™| pays Time Range
™ Sun Mon Tue Wed Thur Fri Sat 00:00 To 00:15 .
Click OK.

The rule is added (or updated) to the policy.

Hide or Show Rule Conditions Columns

To hide or show rule conditions columns in the Rules panel:

Monitoring Health and Wellness of NetWitness Platform 20
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1. Goto ADMIN > Health & Wellness.
2. Click Policies tab.
The Policies view is displayed.
3. Select a policy under a service.
The Policy Detail is displayed.
4. Go to the Rules panel.

Rules
Define the conditions under which you want to trigger an alarm for the NetWitness Platform health problems (definition includes
severity, statistic the alarm applies to, threshold, and threshold at which the alarm clears). After you define the alarm rule, enable or
disable the alarm.
Enable | Name ~ Sewveri Categol Statistic Threshold
U | nable ty goy  Satsic  Threshol
O [ ] Concentrator..  Medium Concentrator Queries Pending Alarm >=5 for 10 MINUTES
O [ ] Concentrator...  Medium Devices Sessions Behind Alarm »>= 100000 for 30 MINUTES
O [ ] Concentrator..  High Devices Sessions Behind Alarm == 1000000 for 30 MINUTES
O [ ] Concentrator...  Critical Devices Sessions Behind Alarm >= 50000000 for 30 MINUTES
O [ ] Concentrator...  Critical Cancentrator Status Alarm !="started’ for 0 MINUTES
O [ ] Concentrator... Critical Datzhaze Status Alarm !="opened’ for 0 MINUTES
O [ ] Concentrator... High Concentrator Rule Error Count Alarm = 0 for 0 MINUTES
1 r i (isi 1 i Bdmen Doem J =1 Al =N £, D RABIITCC

5. Click v to the right of Category , select Columns, and uncheck the Static and Threshold rule
conditions.

You can check or uncheck any Rules column to show or hide it.
The Rules panel displays without the rule conditions.
Delete a Rule

To remove a host or service from a policy:

1. Goto ADMIN > Health & Wellness.

2. Click the Policies tab.

The Policies view is displayed.

3. Select a policy under a service.

The Policy Detail is displayed.
4. Select a rule from the Rules list (for example, Checkpoint).

5. Click = .

The rule is removed from the policy.

21 Monitoring Health and Wellness of NetWitness Platform
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Suppress a Rule

1. Click the Policies tab.

The Policies view is displayed.

2. Select a policy under a service.
The Policy Detail is displayed. You can specify rule suppressions time ranges when you initially add

it or you can edit the rule and specify suppression time ranges.
3. Add or edit a rule.

4. In the Rules Suppression panel of the Add or Edit Rule dialog, specify the days and time ranges

during which you want the rule suppressed.

Suppress a Policy

1. Add or edit a policy.

The Policies view is displayed.
2. In the Policy Suppression panel:

a. Select a time zone from the Time Zone drop-down list.

This time zone applies to the entire policy (both policy suppression and rule suppression).

b. Click ¥ in the toolbar.

c. Specify the days and time ranges during which you want the policy suppressed.

Add an Email Notification

To add an email notification to a policy:

1. Add or edit a policy.

The Policies view is displayed.
2. In the Notification panel:

a. Click ¥ in the toolbar.
A blank EMAIL notification row is displayed.

b. Select the email:

o Notification types in the Recipient column (see "Configure Notification Outputs" in the
NetWitness Platform System Configuration Guide for the source of the values in this drop-down
list).

Monitoring Health and Wellness of NetWitness Platform 22
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o Notification server in the Notification Server column (see 'Configure Notification Servers" in
the NetWitness Platform System Configuration Guide for the source of the values in this drop-

down list).

o Template server in the Template column (see "Configure Notification Templates" in
the NetWitness Platform System Configuration Guidefor the source of the values in this drop-

down list).

Note: Refer to Include the Default Email Subject Line if you want to include the
default Email subject line from the Health & Wellness template in your Health &
Wellness Email notifications for specified recipients.

Delete an Email Notification

To add an email notification to a policy:

1. Add or edit a policy.

The Policies view is displayed.
2. In the Notification panel:
a. Select an email notification.

b. Click — .

The notification is removed.

23 Monitoring Health and Wellness of NetWitness Platform
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Include the Default Email Subject Line

The emails generated by the notifications you set up for policies do not include the subject line from
the Health & Wellness Default Email Notification templates. You need to specify the subject line in the
do not include subject lines. This procedure shows you how to insert a subject line into the templates.

For related reference topics, see Policies View and NetWitness Platform Out-of-the-Box Policies.

To include the subject line from a Health & Wellness email template in your email notification:

1. Goto ADMIN > System.

2. In the options panel, select Global Notifications.

3. Select a Health & Wellness Email Template (for example, Health & Wellness Default SMTP
Template).

RSA' RESPOND INVESTIGATE MONITOR CONFIGURE  ADMIN @]admm 9 @

Hosts Services Event Sources ealth & Wellness System

Info Global Notifications
Updates

Qutput Servers | Templates
Licensing

+ | el Search X

Emai
Name ~ Template Type Description Actions

Global Notifications

Legacy Notifications Audit Logging Defauit Augit CEF Template o3

System Logging e Format

Global Auditing

Jobs

Live Services
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The Define Template dialog is displayed.

4. Click Z, then in the Template field, copy the Subject Line (Highlight the subject line and press
Ctrl-C) into the buffer.
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Mame * Health & Wellness Default SMTP Template

Template Type | Health Alarms

Description Health & Wellness Default SMTP Template

Template * <html=>

4.':!__

// RECOMMEND: Use this line from the template as the Email Subject line
when defining Motification Type

MW Health <#if state == "ACTIVE">%{severity?lower_case?cap_first}
Severity<#elsex${state?lower_case?cap_first}</#if> Alarm:
${ruleName!"Unknown Rule Name"} on ${hostName!"Unknown Host Name™}
—
<head=

<meta http-equiv="Content-Type" content="text/html; charset=UTF-8">

</head>
<body bgcolor="#eeeeee” leftmargin="0" topmargin="0" marginwidth="0"
marginheight="0">
<table border="0" cellpadding="0" cellspacing="0" height="100%"
width="100%" id="bodyTable">

5. Click Cancel to close the Template.

6. Click the Output tab and select a notification (for example Health & Wellness).

7. Click 4.
The Define Email Notification dialog is displayed.

8. Replace the value in Subject field text box with the subject line that you have in the buffer (highlight
the existing text and press Ctl-V).
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Define Email Notification

Enable U
H&W Email notification

To Email Addresses *

Subject Template Type  Health & Wellness default email subject

MW Health <#if state == "ACTIVE"=${severity?lower_case?
cap_first} Severity<#else=%{state?lower_case?cap_first}</#if>
Alarm: ${ruleName!"Unknown Rule Name"} on
${hostName!"Unknown Host Name"}

Cancel

9. Click Save.
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Monitor System Statistics

The System Stats Browser filters statistics by the selected host, component running on the host,
statistical category, individual statistic, or any combination of host, component, category, and
statistic. You can also choose the order in which to display this information.

To access the System Stats browser:

1. Goto ADMIN > Health & Wellness.

The Health & Wellness view is displayed with the Alarms tab open.
2. Click the System Stats Browser tab.

The System Stats Browser tab is displayed.
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Filter System Statistics

You can filter the System Statistics in one of the following ways to monitor:

Statistics collected for a particular host

Statistics collected for a particular component

Statistics collected of a particular type or that belongs to a certain category

« Statistics listed in an ordered way as per the selection chosen

To filter the list of system statistics:

1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.

2. Click System Stats Browser.
The System Stats Browser tab is displayed.
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Regex Cregex ®ascending ODescending g

Host Component Category Statistic Subitem Value Last Update Historical Graph e}

Health Checks

Health Checks

Build Date

Admin Server

Admin Server CPU Urilization

Admin Server Maximum Memory

nwappliance13731 Admin Server

Memery Utiization .

| P s o4 1) B 1 € tems 1-50 of 1160

Filter the list of System Statistics in one of the following ways:

o To view System Stats of a particular host, select the host in the Host drop-down list.
The System Stats for the selected host is displayed.

o To view System Stats of a particular component, select the component in the Component drop-
down list.
The System Stats for the selected component is displayed.
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o To view System Stats of a particular category, type the category name in the Category ficld.
Select Regex to enable Regex filter. It performs a regular expression search against text and lists
out the specified category. If Regex is not selected it supports globbing pattern matching.

The System Stats for the selected category is displayed.

o To order the list of statistics in a preferred order you can set the order in the OrderBy column

o To view a particular statistic across hosts, type the statistic name in the Statistic field.
Select Regex to enable Regex filter. It performs a regular expression search against text and lists
out the specified category. If Regex is not selected it supports globbing pattern matching.
The System Stats for the selected statistics is displayed.

The following figure shows the System Stats Browser filtered by the NWAPPLIANCE10604 host
listed in descending statistical category order.

RSA RESFPOND INVESTIGATE

Host Component Category Statistic subitem valug Last Update Historical Graph

IEED
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3. To view the details for an individual statistic:

a. Select a row to select a statistic.

b. Click
The Stat Details is displayed.
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Stat Detalls 1
Host 031bcf61-073f-4a0d-ae54-adb824593557c ~
Hostname S5ESAPrimary

Component 1D appliance

Component Host

Mame Logical Drive State

Subitemn 0.1

Path

Plugin appliance_diskraid_logicaldrive

Plugin Instance 0.1

Type string

Type Instance state

Description Disk Raid Logical Drive state and other details for drive in

Adapter 0 Virtual Drive 1

Category DiskRaid
Last Updated Time 2018-02-19 07:15:44 AM
Value Optimal
Raw Value Optimal

By 031bcfe1-073f-4a0d-ae54-
adb82493%9fc/appliance_diskraid_logicaldrive-
0.1/string-state

Physical Drives 0.32.3,0.32.2,0.32.4,0.321,0.32.0
stat_collector_wversion 11.1.0.0
Current Cache Policy WriteBack, ReadAhead, Cached, Write Cache OK if Bad BBU ¥

For details on various parameters in the ADMIN > Health & Wellness > System Stats
Browser view, see System Stats Browser View
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View Historical Graph of System Statistics

The historical graph of the collected system stats gives you information about the variation of the stats
over a time frame selected.

To view a historical graph:
1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.
2. Click the System Stats Browser tab.
3. Inthe System Stats Browser tab, specify the filter criteria to display the statistics you want.
4. In the Historical Graph column, select i
The Historical graph for the selected statistic is displayed.

The figure below gives an example of the historical graph for Memory Utilization statistic for a host.

Historical Graph

Host: Memory Utilization Time Frame Current Day v
Zoom Th 6h 12h 1d Al From | Jul 9, 2017 To | Jul 10, 2017
185
19
g
£
185 ®
18
17.5
21:00 10, Jul 03:00 06:00 09:00 12:00 15:00 18:00
10. Jul 06:00 _——12:00 T8:00
n 3
average
Click and drag in the plot area to zoom in

The graphical view is customized to display the statistics collected for the current day and the values
are zoomed in for an interval of an hour (10.15 - 11.15 hrs). Hover over the graph to view the details
at a particular instant. For example, in the figure it displays the memory utilization at 11.00 hrs.

Note: You can customize the graph view by selecting the Time Frame and Date range. You can zoom
in using the zoom in value, time window, or by just a click and a drag in the plot area. For details on
the parameters to customize and zoom in functions, see Historical Graph for System Stats. Any break
or gap in chart line indicates that the service or host was down during that time.
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Monitor Service Statistics

NetWitness Platform provides a way to monitor the status and operations of a service. The Service Stats
view displays key statistics, service system information, and host system information for a device. In
addition more than 80 statistics are available for viewing as gauges, and in timeline charts. Only
statistics for session size, sessions, and packets are viewable in historical timeline charts.

Although different statistics are available for different types of services, certain elements are common
for any Core device.

To monitor service statistics in NetWitness Platform:

1. Goto ADMIN > Services.

The Services view is displayed.

2. Select a service, and select View > Stats in the Actions column.

RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN t:_jj:}admln

Services

. Change Service | E Decoder | Stats ©
Decoder A
o
Key Stats Service System Info Host System Info Physical Drives o
0 MbPS 0% 0 & -
w
0 MbPS 1.005.4 MB 05.4 MB ! o
—~
31.4GB 31.4GB =da n
22 Packets 126.1 MB 22.6 MB :|
0 Packets (0% loss) 31.4GB 31.4GB &
0 Packets 1 hour and 50 minutes
2017-un-120 Ready 4 hours and 33 minutes
2017-un-12 07:5 2017-Jul-10 13:13:48 Ready
2017-ul-10 15:04:35 20174ul-10 10:30:42

Gauges - Page 1 of 1 —+

Memory Process X cpu Memory Process Max
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3. To customize the view: Collapse or expand charts, for example expand the Chart Stats Tray to see
available charts. Drag a section up or down to change the sequence. For example, drag the Gauges

section to the top so that it is above the Summary Stats section.

Add Statistics to a Gauge or Chart

In the Services Stats view, you can customize the monitored statistics for individual services. The Chart
Stats Tray lists all available statistics for the service. The number of statistics varies according to the
type of service being monitored. Any statistic in the Chart Stats Tray can be displayed in a gauge or a
timeline chart. Only statistics for session size, sessions, and packets are viewable in historical timeline
charts.
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Create a Gauge for a Statistic

To create a gauge for a statistic in the Services Stats view:

1. Goto ADMIN > Services.
The Admin Services View is displayed.

2. Select a service and select View > Stats in the Actions column.

The Chart Stats Tray is displayed on the right side.

3. If the tray is collapsed, click <l to view the list of available statistics.

4. From the Chart Stats Tray, click on any statistic and drag it into the Gauges section.

A gauge is created for the statistic. If there is no space for the gauge, a new page is created on the
Gauges section and the gauge is added to the new page. In the example, the Active CPU Time chart
was added to the Gauges section by dragging it from the Chart Stats Tray.

Gauges - Page 1 of 1

s BX cpy

745.1MB
852 6MB

259.2MB

1.0GB

Process

£ X

Memory Process Max

Name -
Dis...
Path

Sta..

X active CPU Time X

Value
Memory Process Max
Isysistats/memory.process.max

memaory.process.max

Active CPU
Time

Create a Timeline Chart for a Statistic

To create a timeline for a statistic:

From the Chart Stats Tray, click on a statistic and drag it into the Timeline Charts or the Historical

Timeline Charts section.

A timeline chart is created for the statistic. If there is no space for the chart, a new page is created on
the Timeline Chart section and the chart is added to the new page. In the example, the Assembler Packet
Pages chart was added to the Timeline Charts section by dragging it from the Chart Stats Tray.
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1 i A —
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Search for a Statistic in the Chart Stats Tray

To search for a statistic, type a search term; for example, session, in the Search field
and press RETURN. Statistics that match are displayed with the matching word highlighted.

Chart Stats Tray >

Search |session| X

Stats

Assembler Sessions
Stat Mame:assembler.sessions
Path:/decoder/stats/assembler.zessions

Session Bytes
Stat Mame:session.bytes
Path:/database/stats/session. bytes

Session Bytes Last Hour
Stat Name:session.bytes.last.hour
Path:/database/stats/session. bytes.last.hour

Session Completion Queue
Stat Mame:pocl.session.complete
Path:'decoder/parsers/stats/pocl.session.complete

Session Correlation Queue
Stat Name:pool.session.correlate
Path'decoder/stats/pool.session.correlate

5ession Decrement Queue
Stat Name:pool.session.decrement
Path:'decoder/stats/pool.session.decrement

Session Export Cache Files

Stat Name:=xport.session.cache.files
Path:/'decoder/stats/export.session.cache.files =

| Page 1+ of2 | ¥ » | C Stats 1-12 of 24
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Edit Properties of Statistics Gauges

The Gauges section of the Service Stats view presents statistics in the form of an analog gauge. The
properties of each individual gauge are editable; all gauges have an editable title and some have
additional editable properties.

Edit Properties of a Gauge

1. Goto ADMIN > Services

The Admin Services view is displayed.

2. Select a service and select View > Stats in the Actions column.

The Service Stats view includes the Gauges section.

3. Go to the gauge for which you want to edit properties (for example, Memory Process).

Memory Process Max X

31.4GE8

5058 44 DGE
25GE 50.3GE
53GE 39422 55 6GE

0.0 Memory Process 62.8GE
Max

4. Click the Properties icon (']:}) to display the parameter names and values.

5. To highlight the value of the Display Name field, double-click on the value; for example, Memory

Process.

Note: Clicking the other two values does nothing because the properties are not editable in
the gauge.

6. Type a new value for the Display Name and click the Properties icon ('ﬁ} ).

The new title replaces Memory Process.

Add Stats to the Gauges Section
You can add more gauges by dragging a statistic from the Chart Stats Tray into the Gauges section.

1. To expand the Chart Stats Tray, click <l .

2. Scroll down and select a statistic, for example, Session Rate (maximum).
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3. Drag the statistic to the Gauges section.

The new gauge is displayed in the Gauges section.

Edit Properties of Timeline Charts

Timeline charts display statistics in a running timeline. The Service Stats view includes two types of
timelines: current time and historical. You can drag any statistic available in the Chart Stats Tray to the
Timeline Charts section. Only statistics for session size, sessions, and packets are viewable in historical
timeline charts. The properties of an individual timeline chart are editable; all timeline charts have an
editable title and some have additional editable properties.

To access the charts:
1. Goto ADMIN > Services.
2. Select a service and click Stats.

The Services Stats view is displayed. The charts are in this view.

Edit Properties of a Timeline

To edit properties of a timeline chart:

1. Go to the timeline chart for which you want to edit properties (for example, Memory Process).

Timeline Charts - Page 1 of 1 ~—+

Memory Process BX CPU X

1.18

838 2M
558.8M
ITEAM

0.0
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I I I I | T ] I
11:08 am 11:08 am 11:10 am 11:11am 11:13 am 11:08 am 11:08 am 11:10 am 11:11am 11:13am

Memory Process Max X Assembler Packet Pages &X
aris 2t
e e
8 ]

2. Click the Properties icon (ﬁ:’ ) to display the parameter names and values.

3. Double-click on a value (for example, the Display Name field) to make the value editable.

Note: Clicking the other two values does nothing because the properties are not editable in the
chart.

4. Type a new value and click the Properties icon.

The timeline chart is displayed with new values.

Edit Properties of a Historical Timeline

To edit properties of a historical timeline chart:
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1. Go to Historical Timeline Charts.

2. Click the Properties icon (ﬁ} ) to display the parameter names and values.
3. Click on a value (for example, 01/27/2015 for the Begin Date ficld) to make the value editable.
4. Type a new value.

5. Edit the End Date and Display Name if required.

6. Click the Properties icon (ﬁ} ).

The historical timeline is displayed with new values.

Note: To return the properties of the historical timeline chart back to the default so that the values
dynamically update, remove the Begin Date and the End Date, place your cursor in the Begin Date
field, and refresh your browser.

Add Stats to Timeline Charts

You can add timeline charts by dragging a statistic from the Chart Stats Tray into the Timelines section.
1. To expand the Chart Stats Tray, click <I .

2. Scroll down and select a statistic; for example, Session Rate (maximum).

3. Drag the statistic to the Timelines Section.

The new timeline is displayed in the Timelines section.

Monitor Hosts and Services

NetWitness Platform provides a way to monitor the status of hosts and services installed. You can view
the current health of all the hosts, services running on the hosts, their CPU usage and memory
consumption and the host details and service details.

To monitor hosts and services in NetWitness Platform:

1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.

2. Select the Monitoring tab.
A list of all hosts and their associated services that belong to the group All is displayed by default.

The operational status, CPU usage, and memory usage for each host is displayed.
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3. A list of services installed on the selected host is displayed.

Logical Drive Problems

0 hosifs)

Ite

Full Filesystems
0 hosts)

3 days 21 howrs 45 mingies 31 seconds

The name, operating status, CPU usage, memory usage, and the time operating for each service is

displayed.

Filter Hosts and Services in the Monitoring View

You can filter hosts and services in the monitoring view in one of the following ways:

o Hosts belonging to a particular group
o Specific host and its associated services

o Hosts whose services are stopped

o Hosts whose services have stopped processing or processing has been turned off

o Hosts that have Physical drive problems
o Hosts that have Logical drive problems

o Hosts that have Full File systems

For the related reference topic, see Monitoring View.

To filter hosts and services:
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1.

Go to ADMIN > Health & Wellness.

The Health & Wellness view is displayed with the Alarms tab open by default.
Select the Monitoring tab.

Filter the hosts and services in one of the following ways:

o To view a list of hosts and their associated services belonging to a particular group, select the
group in the Groups panel.

All hosts and their associated services belonging to the specified group are displayed in the Hosts
panel.

Note: The grouping of hosts is derived from the groups created in the Administration page. All
groups created in the Administration page are displayed here.

For example, if you select the group LC_Group in the Groups panel, a list of all hosts that are
part of the group are displayed.

o To view a list of all services that have stopped processing, click Stopped Processing in the Hosts
panel.

A list of all the hosts that have at least one service with the status as stopped processing is
displayed.

Note: The buttons on the top display the System Statistics for all the hosts configured in
NetWitness Platform and does not change with application of filters on groups.

RSA' RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Monitoring Policies System Stats Browser  Event Source Monitoring Settings

Groups Hosts Filter
Hame Sount Stopped Services Stopped Processing Physical Drive Problems Logical Drive Problems Full Filesystems
San © 0 5 0 host(s) 0 host(s) 2 host(s)
B NWAPPLIANCES Status: CPU: 6.15% Memory: 21.78 GB/31.42 GB
Service Health Status ~ Rate Name Service Type cPU Memory Usage Uptime
Ready L ] 0 Broker 0.3% 22.18MB 1 day & hou
Ready Reporting Engine 1.2% 1.53GB 1 day & hou
Ready Orchestration Server 0.2% 753.33MB 1 day 8 hou
Ready - Security Serve Security Server 0.2% 664.82 MB 1 day & hou
Ready - Admin Serve Admin Server 0.1% 728.84 MB 1 day & hou
Ready - Config Se Config Server 0.1% 688.21 MB 1 day & hou
Ready - vestigate Serv Investigate Server 678.83 MB 1 day 8 hou
Ready - Respor Respond Server 742.28 MB Tday8hoy
»
| Page 1 | of1 | | C Displaying 1 -5 of 5
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Note: In a similar way you can filter the list of hosts and the associated services by choosing the right
filter

- Click Stopped Services to display a list of all stopped services.

- Click Physical Drive Problems to display a list of host with Physical Drive Problems.

- Type the host name in the Filter box to display only the required host and the services running on the
host.

Monitor Host Details

You can view the details of the host, its memory and CPU usage, system information, the physical drive,
logical drive and file system details to further investigate if you encounter some problem with the host.

To view host details:

1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.

2. Select the Monitoring tab.
3. Click a host in the Hosts panel.

The Host Details view is displayed as a new page.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN @:‘admln

Healt ness

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCE9 @

HOST AND SERVICE + £t
Host Details
| Host
System Info
Broker
Host NWAPBLIANCED Memory Utilization 69.18%
Reporting Engine oy 3015 Used Memory
R TSRS Running Since 2017-Jul-10 09:44:02 Total Memory
Security Server Current Time 2017-Jul-11 16:43:42 Cached Memory
NETT Uptime 1 day & hours 59 minutes 40 seconds Swap Utilization
P . Used Swap
| System Info nux 3.10.0-514.26.2.217.x86_64 x86_64
Linux 3.10.0-514.26.2.e17.x86_64 x86_64
Config Server - - Total Swap 4.00 GB
Investigate Server
Respond Server Physical Drive || Logical Drive || File System Adapter Message Bus
State Enclosure slot Failure Count  Raw Size Inquiry Data
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Monitor Service Details

You can view the details of a service, its memory and CPU usage, system information, and various
details depending on the service selected.
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To view service details:

1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.
2. Select the Monitoring tab.
3. Click £ for a host in the Hosts panel.
A list of services running on the host is displayed.
4. Click on any service.
The service details view is displayed as a new page. The Archiver, Broker, Concentrator, and
Decoder service details views have the Service and Details panels.
RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN ::ﬂ::‘idmln
Health & Wellness
Alarms MOl'lithil'ls Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCE10604 - NWAPPLIANCE22655 @
FosTAnE sEREE Concentrator Details
Host
Service
I Concentrator
CPU 0.5% Used Memory
Running Since 2017-Jul-10 10:30:32 Max Process Memaory
Build Date 2017-Jul-09 07:19:42 Version Information
Details
Aggregation State started Time Begin
Meta Rate 0 Time End
Meta Rate Max 97222
Session Rate 0
Session Rate Max 1943
The Event Stream Analysis (ESA) service details view has the Serviceand Details panels, plus the
Monitor and JVM tabs that show additional statistics.
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN
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The Malware Analysis service details view has the Service panel plus the Rules, Events, and JVM
tabs that show additional statistics.
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Malware Details

Host
Service

Broker

13 . Anahre CcPU Used Memory
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Running Since Max Process Memory
Build Date Version Information

Events M

Number Of nts For Past 24 Hours Average Processing Time
Number Of Files For Past 24 Hours Events In Queue
Number Of Events For Past 7 Days Events Processed
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The Reporting Engine service details view has the Service panel plus the Report and JVM tabs that
show additional statistics.

or Past 3 Months
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Alarms

Host
Broker

I Reporting Engine
Orchestration Server
Security Server
Admin Server
Config Server
Investigate Server

Respond Server

INVESTIGATE

Monitoring

MONITOR CONFIGURE ADMIN

Health

Policies System Stats Browser

Reporting Engine Details

Service
CPU 14.8%
Running Since 2017-Jul
Build Date

Report VM

Number Of OAs Failed In Last Hour
Number Of Reports Failed In Last Hour
Number Of Rules Failed In Last Hour
Maximum Time Taken For RE Request
Number Of Requests Completed

Max Number Of Rows Fetched For
Charts

Number Of Chart Executions Failed In
Last 10 Mins

Number Of Enabled Charts

Event Source Monitoring,

Settings

-10 10:04:28

0

215 milliseconds

2543

NWAPPLIANCE9 @

Used Memory
Max Process Memory

Version Information

Number Of Active Requests
Average Time Taken For RE Requests

Number Of Enabled Alerts

(@ admin &

0 milliseconds

Number Of Alert Execution Failed In Last

10 Minutes
Max Rows Fetched For Alerts

Number Of Requests Failed In Last 10
Mins

Number Of Requests Received

Number Of Requests Failed

b
A
[

o M

RS /\ NETWITNESS PLATFORM

Note: Alternatively, you can access the service details page by clicking the services listed in the
options panel in the Host Details view.

Refer to Monitoring View for a detailed description of the Details view for each service.

Monitor Event Sources

The event source monitoring feature of NetWitness Platform provides the following functionalities:

Support for failover

o Provides a consolidated list of event sources and their associated collector and log decoder devices

o Decommission

Regex support for rules

« Filtering capabilities

Historical graph

In addition, you can monitor event sources, check the number of events generated from a source type and

view the historical graph of the events collected. To monitor event sources you have to configure the

event sources so that they generate and send out notifications when required.
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Configure Event Source Monitoring

To monitor event sources you have to configure the event sources so that they generate and send out
notifications when required. For the related reference topic, see Health and Wellness Settings View -
Event Sources.

To configure and enable event monitoring in NetWitness Platform:
1. Goto ADMIN > Health & Wellness.
2. Select Settings > Event Source.

The Event Source tab is displayed.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Health & Wellness

Alarms Monitoring Policies System Stats Browser ~ Event Source Monitoring Settings
To menitor Event Sources, see Event S ment. To monitor Archiver and Warehouse Connector, see
Event Source Archiver Warehouse Connector

Event Source Monitoring

hese setting dictate when to generate notifications for event sources that the system is no longer receiving logs from and where t
nd those notificat

+

Regex  Source Type Source Host Time Threshold

Hours Minutes
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3. Under Event Source Monitoring, click +.
The Add/Edit Source Monitor dialog is displayed.
4. Define the Source Type, Source Host, and Time Threshold for the source of the event source that

you want to monitor to detect when NetWitness Platform stops receiving logs from it. If you do not

specify a Time Threshold, NetWitness Platform monitors the event source until you set a threshold.

Note: For Source Type and Source Host, you must specify the values that you configured for
the event source in the Event Sources tab of the Administration > Services > Log Collector
service > View > Config view. You add or modify the the event sources that you want to
monitor. The two parameters that identify an event source are Source Type and Source Host.
You can use globbing (pattern matching and wildcard characters) to specify the Source Type
and Source Host of event sources
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Add/Edit Source Monitor

[ Regex

Source Type *

Source Host *

0 Hours

Time Threshold *
0 Minutes

5. Click OK.
The event source is displayed in the panel.

6. Configure the method of notification, by doing one of the following:
o Select Configure email or distribution list.

The AMIN > System > Email Configuration Panel is displayed so that you can specify to whom
the notifications are sent.

o Select Configure Syslog and SNMP Trap servers.

The Administration > System Auditing Configuration panel is displayed so that you can configure
the Syslog and SNMP Traps to which the notifications are sent.

7. Click Apply.

NetWitness Platform begins sending notifications when it stops receiving events from this event
source after the time threshold has elapsed.

For details on parameters in the Event Source Monitoring settings view, see Event Source Monitoring
View.

Decommission Event Source Monitoring

If a Log Collector service (Local Collector or Remote Collector) for which you set up Event Source
monitoring becomes inoperable, NetWitness Platform continues to notify that you it is not receiving
events from it until you decommission the Collector.

Caution: If you configured a failover Local Collector for a Remote Collector and the Local Collector
fails over to a standby Log Decoder, you must decommission the Local Collector to stop the
notifications.

To decommission event source monitoring for an event source:
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. Go to ADMIN> Health & Wellness.

Select Settings > Event Source.

The Event Source tab is displayed.

Under Decommission, click +.

The Decommission dialog displays.

Define the Source Type and the Source Host for the source for which you want to decommission

event monitoring notifications.

Decommission

= Regex

Source Type *  apache

Source Host *

Cancel

Filter Event Sources

You can choose a filter to display:

Events belonging to a particular event source
Events belonging to particular event source types
Events collected from a particular log Collector

Events list arranged in a order based on the Event Source Type, Log Collector, Log Decoder or Last

Event Time.

To filter the list of event sources:

1.
2.

3.

Go to ADMIN > Health & Wellness.
Select Event Source Monitoring.
Filter the list in one of the following ways:

o To view the events generated by a particular event source, type the required event source in the

Event Source field. Select Regex to enable Regex filter and click Apply. It performs a regular
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expression search against text and lists out the specified category. This field also supports
globbing pattern matching.
All events generated by the Event Source specified are displayed.

o To view events collected from a particular Log Collector, select a Log Collector from the drop-
down list and click Apply.
A list of all events being collected from the specified Log Collector from various event sources is

displayed.

Note: Similarly, you can also choose the following filters:

- To view events belonging to an event source type, select the event source type and click Apply.

- To view events received in a specified time frame, select the required time frame and click Apply.
You can further filter the query results to contain only event sources that logs have been received from
within the selected time or the query results to contain only event sources that logs have not been
received from within the selected time.

For details on various parameters and description, see Event Source Monitoring View.

View Historical Graph of Events Collected for an Event Source

The historical graph of the events collected from an event source gives you information about the
variation of the collection over a time frame selected.

To view a historical graph:

1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.

2. Click Event Source Monitoring.

The Event Source Monitoring view is displayed.

3. In the Historical Graph column, select i

The Historical graph for the selected event source is displayed.

The figure below gives an example of the historical graph for the event source type winevent_snare.
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Historical Graph

winevent_snare: "8 8 84 08 Time Frame CurrentDay
Zoom 1h 6h 12h 1d Al From | Jul 9, 2017 To | Jul 10,2017

0.0075
0.005 3
2

0.0025

1]

21:00 10. Jul 03:00 0&:00 0%:00 12:00 15:00 18:00
HH
10. Jul 06:00 Wdlgg 1800
i +
average
Click and drag in the plot area tc zoom in

The graphical view is customized to display the events collected for the current day and the values
are zoomed in for an interval of an hour (09.05 - 105.05 hrs). Hover over the graph to view the details
at a particular instant. For example, in the figure it displays the average rate of collection at 09.30
hrs.

Note: You can customize the graph view by selecting the Time Frame and Date range. Y ou can zoom
in using the zoom in value, time window, or by just a click and a drag in the plot area. For details on
the parameters to customize and zoom in functions see Health and Wellness Historical Graphs
collected from an event source.

If there is no data displayed on the chart it may be due to one of the following reasons:

- event source is down.

- event source is not processing anything right now.

Monitor Alarms

You can set up alarms and monitor them in the Health and Wellness interface for the hosts and services
in your NetWitness Platform domain. Alarms display in the view as Active when the Policy-rule-defined
statistical thresholds for hosts and services have been crossed. Alarms are grayed out and change to the
Cleared status when the clearing threshold has been crossed.

You set up the parameters for alarms in Manage Policies. For the related reference topic, see Health and
Wellness View - Alarms View.

To monitor the alarms set up in NetWitness Platform:
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2.

3.

Go to ADMIN > Health & Wellness.

The Health & Wellness view is displayed with the Alarms tab open by default.
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Click on the alarm for which you want to display details in the Details Panel.

Click (expand) to view the details for the alarm you selected.
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Alarm Details

191-1037-0007

Time 2017-07-10 10:35:43 AM

State ACTIVE

Severity CRITICAL

Hostname NWAPPLIANCEZ2E55

Service Concentrator

Policy Concentrator Monitoring Policy
Rule Mame Concentrator Meta Rate Zero

nformational Text

This Concentrator is not receiving meta from its

upstream services, which is indicative of an
aggregation problem or capture problem on an
upstream service,

Possible Remediation Action:

Pleasze check whether aggregation iz started on
the Concentrator, and whether all upstream
Decoders from which it is aggregating are in a
'‘consuming' state. There should be additional
corresponding alarms if this is not the case.

To check the assresatinon status of this

Monitor Health and Wellness Using SNMP Alerts

You can monitor an NetWitness Server component to proactively alert using Simple Network
Management Protocol (SNMP) based on the thresholds or system failures.

Y ou can monitor the following for NetWitness Platform components:
o CPU utilization that reaches a defined threshold.

o Memory utilization that reaches a defined threshold.

o Disk utilization that reaches a defined threshold.
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SNMP Configuration

The NetWitness Servers can be configured to send out SNMPv3 Threshold Traps and Monitor Traps.
Threshold traps are sent in conjunction with configured node thresholds by the NetWitness Platform Core
applications themselves. Monitor traps are sent by the SNMP daemon itself for the items indicated in its
configuration file. The customer must set up the SNMP daemon on another service to receive SNMP
traps from NetWitness Platform. You can set up SNMP on NetWitness Platform in the configuration
setting for the NetWitness Server. For more information, see "Service Configuration Settings" in the
NetWitness Platform Host and Services Getting Started Guide for the specific host.

Thresholds

Thresholds can be set on any service statistics that can accept the setLimit message. You can retrieve
the current thresholds using the getLimit message. To set a limit, you can pass a low and high threshold
value.

When the value of the stat crosses either the low or high threshold, a SNMP trap is triggered indicating
the threshold is crossed. The trap will not be triggered if the value is below the low and above the high
value, but another trap is triggered if it crosses back into the normal range (above the low and below the
high).

You must set the threshold for the service using the Service Explorer view or the REST API.

Following is a sample threshold for monitoring CPU usage (below 10% or above 90%):

/sys/stats/cpu setLimit low=10 high=90

Following is an example of how the threshold is set using REST API:

http://<log decoder>:50102/sys/stats/cpu?msg=setLimit&low=10&high=90

If the CPU usage spikes to 90% or higher, a SNMP trap will be generated:

23435333 2013-Dec-16 11:08:35 Threshold warning path=/sys/stats/cpu 0ld=77%
new=91

Configure SNMPv3 for a Host

1. Goto ADMIN > Services.

The Services view is displayed.
2. Select the service.
3. Inthe Actions column, select View > Explore.

4. 1In the nodes list, expand the list and select a config folder. For example, logs > config
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Set the SNMPv3 configuration.
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Set the Threshold for a Service

1. Goto ADMIN > Services.

The Services view is displayed.
2. Select the service.
3. Inthe Actions column, select View > Explore.
4. In the nodes list, expand the list and select a stat folder.

5. Select a stat, for example, cpu, and right-click.
6. From the drop-down menu, select Properties.

The Properties panel is displayed. The Properties panel has a drop-down list of available messages
for the parameter.

| St

get
getlimit
help
info

setlimit

7. Select setLimit.

8. Specify the low and high values.
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SNMP Traps for System Status

The threshold mechanism can also be used to monitor string-valued stats generated by Core services.
There are two ways to monitor string-valued stats:

1. Generate a trap whenever the status value is NOT an expected value. For example, if you want
monitor the stat /broker/stats/status and generate a trap whenever the value is not started,
set the high limit on the stat to the expected value. You would use the setLimit message on

/broker/stats/status as follows:
setLimit high=started

2. Generate a trap whenever the status value matches an expected value. This is accomplished by using
the 1ow limit on the stat. For example, if you wanted generate a trap when the stat
/sys/stats/service.status has the value "Initialization Failure", you would use the

setLimit message on /sys/stats/service.status as follows:
setlLimit low="Initialization Failure"

In both of these scenarios, it is possible to check for multiple values by using a comma-separated list of
values to check for.

Troubleshooting Health & Wellness

Issues Common to All Hosts and Services

You may see the wrong statistics in the Health & Wellness interface if:

o Some or all the hosts and services are not provisioned and enabled correctly.

e You have a mixed-version deployment (that is, hosts updated to different NetWitness Platform

versions).

o Supporting services are not running.

Issues Identified by Messages in the Interface or Log Files

This section provides troubleshooting information for issues identified by messages NetWitness Platform
displays in the Health & Wellness Interface or includes in the Health & Wellness log files.

User Interface: Cannot connect to System Management Service
System Management Service (SMS) logs:

Caught an exception during connection recovery!
java.io.IOException
at com.rabbitmg.client.impl.AMQChannel.wrap

(AMQChannel.java:106) at
com.rabbitmg.client.impl.AMQChannel .wrap
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(AMQChannel.java:102) at
com.rabbitmg.client.impl.AMQConnection.start (

AMQConnection.java:346) at
com.rabbitmg.client.impl.recovery.

RecoveryAwareAMQConnectionFactory.
newConnection

(RecoveryAwareAMQConnectionFactory.java:36)
at com.rabbitmg.client.impl.recovery.

AutorecoveringConnection.
recoverConnection (AutorecoveringConnection.java:388)
at com.rabbitmg.client.impl.recovery.

AutorecoveringConnection.beginAutomaticRecovery
(AutorecoveringConnection.java:360)

at
com.rabbitmg.client.impl.recovery.AutorecoveringConnection.

access$000 (AutorecoveringConnection. java:48)
at com.rabbitmg.client.impl.recovery.

AutorecoveringConnection$l.shutdownCompleted
(AutorecoveringConnection.java:345)
at com.rabbitmg.client.impl.ShutdownNotifierComponent.

notifyListeners (ShutdownNotifierComponent.java:75)

at com.rabbitmg.client.impl.AMQConnection$MainLoop.run
(AMQConnection.java:572)

at java.lang.Thread.run (Thread.java:745)

Caused by: com.rabbitmg.client.ShutdownSignalException:
connection error at
com.rabbitmg.utility.ValueOrException.getValue
(ValueOrException.java:67)

at com.rabbitmg.utility.BlockingValueOrException.

uninterruptibleGetValueBlockingValueOrException.java:33)
at
com.rabbitmg.client.impl.AMQChannel$BlockingRpcContinuation.

getReply
(AMQChannel.java:343)
at com.rabbitmg.client.impl.AMQConnection.start
(AMQConnection.java:292)

8 more
Caused by: java.net.SocketException: Connection reset
at java.net.SocketInputStream.read
(SocketInputStream.java:189)
at java.net.SocketInputStream.read
(SocketInputStream.java:121)
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at java.io.BufferedInputStream.fill
(BufferedInputStream.java:246)

at java.io.BufferedInputStream.read
(BufferedInputStream.java:265)

at java.io.DatalnputStream.readUnsignedByte
(DataInputStream.java:288)

at com.rabbitmg.client.impl.Frame.readFrom (Frame.java:95)
at com.rabbitmg.client.impl.SocketFrameHandler.readFrame
(SocketFrameHandler.java:139)

at com.rabbitmg.client.impl.AMQConnection$MainLoop.run
(AMQConnection.java:532)

RabbitMQ service not running on the NetWitness Server.

Restart the RabbitMQ, SMS, and NetWitness Platform services using the
following commands.

systemctl restart rabbitmg-server

systemctl restart rsa-sms

systemctl restart jetty

User Interface: Cannot connect to System Management Service

The System Management Service, RabbitMQ, or Mongo service is not running.

Run the following commands on NetWitness Server to make sure all these services are
running,.
[root@nwserver ~]# systemctl status rsa-sms
RSA NetWitness SMS :: Server is not running.
[root@nwserver ~]# systemctl start rsa-sms
Starting RSA NetWitness SMS :: Server...
[root@nwserver ~]# systemctl status rsa-sms
RSA NetWitness SMS :: Server is running (5687).
[root@nwserver ~]# systemctl status mongod
mongod (pid 2779) is running...
systemctl status rabbitmg-server
Status of node nwllocalhost

[{pid, 2501},
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{running applications,
[{rabbitmg federation management, "RabbitMQ Federation
Management",

"3.3.4"},

User Interface: Cannot connect to System Management Service

/var/lib/rabbitmg partition usage is 70% or greater.

Contact Customer Care.

User Interface: Host migration failed.

One or more NetWitness Platform services may be in a stopped state.

Make sure that the following services are running then restart the NetWitness Server:
Archiver, Broker, Concentrator, Decoder, Event Stream Analysis, Response Server,
IPDB Extractor, Log Collector, Log Decoder, Malware Analysis, Reporting Engine,

Warehouse Connector, Workbench.

User Interface: Server Unavailable.

One or more NetWitness Platform services may be in a stopped state.

Make sure that the following services are running then restart the NetWitness Server:

Archiver, Broker, Concentrator, Decoder, Event Stream Analysis, Response Server,
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IPDB Extractor, Log Collector, Log Decoder, Malware Analysis, Reporting Engine,

Warehouse Connector, Workbench.

User Interface: Server Unavailable

System Management Service (SMS), RabbitMQ, or Mongo service is not running.

Run the following commands on NetWitness Server to make sure all these services are
running,
[root@nwserver ~]# systemctl status rsa-sms
RSA NetWitness SMS :: Server is not running.
[root@nwserver ~]# systemctl start rsa-sms
Starting RSA NetWitness SMS :: Server...
[root@nwserver ~]# systemctl status rsa-sms
RSA NetWitness SMS :: Server is running (5687).
[root@nwserver ~]# systemctl status mongod
mongod (pid 2779) is running...
systemctl status rabbitmg-server
Status of node nwllocalhost
[{pid, 2501},
{running applications,
[{rabbitmg federation management, "RabbitMQ Federation
Management",

"3.3.4"},

Make sure /var/lib/rabbitmg partition is less than 75% full

Check NetWitness Server log files (var/1ib/netwitness/uax/logs/nw.log) for

any errors.

ContextHub stops and does not allow you to add or edit data sources and lists.
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The storage is full by 95% or above.

Increase the storage by updating the YML file, located at /etc/netwitness/contexthub-
server/ contexthub-server.yml.
For example, to increase storage from 120 to 150 GB, enter a value (in bytes) by

editing the relevant parameter: rsa.contexthub.data.disk-size:
161061273600

Delete unwanted or unused large list.

Configure the TTL index for the list to automatically delete STIX and TAXI data and

to clean up storage space.

Context Hub runs on a fixed memory and 50% is reserved for cache. When cache is

100% full, the cache response stops. For all new lookups the response will be slow.

The cache is full by 50% or above.

By default, Context Hub cleans the cache every 30 minutes. Reduce the cache

expiration time of data sources.

Disable cache for data sources.

Increase the RAM of the CH Java process by editing the —Xmx option available in the
/etc/netwitness/contexthub-server/contexthub-server.conf file. In JAVA OPTS, search
for the —-xmx option.

For example, edit the entry as follows:

-Xmx8G

where 8G represents 8GB space. Then restart the ContextHub service.

Note: The memory is less than the available system memory. Be aware that there
are many other services running on the host.

List Data Source displays an unhealthy stats or status.
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Unable to:

« access the data source

o parse or read a CSV file

o schema mismatched CSV

Unable to authenticate when accessing the data source.

Make sure to save the csv file at correct location i.e/var/lib/netwitness/contexthub-

server/data/ and verify the required read permissions.

Make sure the csv file schema specified while configuring the data source matches. If
not, then either create a new data source with the new schema or edit the csv file to
match the schema. For example, if you configure a List Data Source with a schema
with columnl, column2, and column3. And next time you update the csv file where the
number of column increase or decrease or the order of the columns are changed. In
this case there is a schema mismatch and the configured list data source will show

“Unhealthy” in Health and Wellness stats.

Make sure the password is correct. To confirm edit the data source, enter the
password and click test connection.

For more information related the above solutions, see "Configure Lists as a Data
Source" topic in the Context Hub Configuration Guide.

Issues Not Identified by the User Interface or Logs

This section provides troubleshooting information for issues that are not identified
by messages NetWitness Platform displays in the Health & Wellness Interface or includes in the Health
& Wellness log files. For example, you may see incorrect statistical information in the Interface.

Incorrect statistics displayed in Health and Wellness interface.

SMS service is not running. SMS service must be running on the NetWitness Server.
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Restart SMS service.

NetWitness Platform does not show the version to which you upgraded until

you restart jettysrv (jeTTy server).

When NetWitness Platform checks a connection, it polls a service every 30 seconds to
see if it is active. During that 30 seconds, if the service comes back up, it will not get

the new version.

1. Manually stop the service.
2. Wait until you see that it is it offline.

3. Restart the service.

NetWitness Platform displays the correct version.

NetWitness Server does not display the Service Unavailable page.

After you upgrade to NetWitness Platform version 10.5, JDK 1.8 is not default version
and this causes the jettysrv (jeTTy server) to fail to start. Without the jeTTy server, the

NetWitness Platform server cannot display the Service Unavailable page.

Restart jettysrv.

The SMS service is stopped and the following error is displayed in the log file:

java.lang.OutOfMemoryError: Java heap space

You can use the following solution to increase the memory according to your needs.

1. Open /opt/rsa/sms/conf/wrapper.conf
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2 root@NWAPPLIANCE3290:

Replace wrapper.java.additional.l=-Xmx8192m with:
wrapper.java.additional.l=-Xmx16g

Restart the SMS service:

systemctl start rsa-sms
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Managing NetWitness Platform Updates

RSA issues NetWitness Platform software version updates on a regular basis as it strives to continually
improve the product. A software version update consists of a release, service pack, or patch (including
security patch) and ancillary software on which the release, service pack, or patch depends. User guides
are provided for each software version update release, which include detailed steps for installing the
update. It is important that you download the update guide for the release from RSA Link
(https://community.rsa.com/community/products/netwitness) and follow the steps described there.
Additional information is available in the "Apply Version Updates to a Host" topic in the Hosts and
Services Getting Started Guide and in System Updates Panel - Settings Tab.
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Displaying System and Service Logs

NetWitness Platform provides views into system logs and service logs. When you view service logs, you

can also select messages for the service or host.

View System Logs

1.

2. In the options panel, select System Logging.

Go to ADMIN > System.
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Display Service Logs

To display NetWitness Platform service logs:

1.

Go to ADMIN > Services.

2. Inthe Services grid, select a service.
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3. Inthe Actions column, select View > Logs.
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Filter Log Entries

To filter the results shown in the Realtime tab:

L.

(Optional) For system and service logs, select a Log Level and a Keyword, or both. System logs
have seven log levels. Service logs have only six log levels because they do not include the TRACE
level. The default is ALL log entries.

(Optional) For service logs, select the Service: host or service.

Click Filter.

The view is refreshed with the most recent 10 entries matching your filter. As new matching log
entries become available, the view is updated to show those entries.

Show Details of a Log Entry

Each row of the Realtime tab Log grid provides the summary information of a log entry. To view
complete details:
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1. Double-click a log entry.

The Log Message dialog, which contains the Timestamp, Logger Name, Thread, Level and
Message, is displayed.

Log Message

Timestamp 2N 7-06-22T07:47:12.000
Logzer Mame Engine

Thread

Lewvel AJDIT

Mezzage lzer ezcalateduser (seszion 343, :35328) has logeed
out

2. After viewing, click Close.

Access Reporting Engine Log File

All Log Files

The Reporting Engine stores the following logs in the rsasoc/rsa/soc/reporting-engine/log directory:

o Current logs in the reporting-engine.log file.

o Backup copies of previous logs in the reporting-engine.log.* file.

o All UNIX script logs in the files that have the following syntax: reporting-engine.sh_timestamp.log

(for example, reporting-engine.sh _20120921.log).

The Reporting Engine rarely writes command line error messages to the rsasoc/nohup.out file.

Upstart Logs

The Reporting Engine appends the log messages and output written by upstart daemon and the commands
used to start the reporting-engine to the /var/log/secure directory.

An upstart log file is a system log file so only the root user can read it. The Reporting Engine generates
log files, retains backup copies of previous log files, stores UNIX script log files, and appends upstart
log files to another directory.
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Search and Export Historical Logs

NetWitness Platform provides a searchable view of the NetWitness Platform log or the service log in a
paged format. When initially loaded, the grid shows the last page of the log entries for the system or the
service. You can export logs from the current view.

Display the Historical System Log

To display the historical log for the system:

1. Goto ADMIN > System.

2. In the options panel, select System Logging.

The System Logging panel is opened to the Realtime tab by default.

3. Click the Historical tab.

A list of historical logs for the system is displayed.

RSA RESPOND

INVESTIGATE MOMITOR CONFIGURE

ADMIN

Info =

System Logging

Updates - .
Realtime Historica
Licensing
B
T Dac i
Email
Timestamp

Global Notifications
Legacy Notifications
System Logging
Global Auditing

Jobs

Live Services

URL Integration
Context Menu Actions
Investigation

oA

ESA Analytics

ESA Analyrics - Whois
HTTP Proxy Settings

NTP Settings

2017-08-22T21:48:21.806 W

W | Page 21

End Date B ALL V|| Keywords

Level

b
(a1

S h h m hn m m owm
00 0 0|0 0 0 0

n
Q

n
Q

n
Q

FO
FO
NFO
NFO
NFO
FO

RN

ofdtl |

Seuings

Search ™ Export

il
Q
il

Starting Telemetry Ru
Zrarung Telemetry Parse

Starting Telematry Rule Stat Collection

No Features Available in LLS

Displaying 2001 - 2020 of 2020
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Display a Historical Service Log
To display the historical log for services:
1. Select ADMIN > Services.
2. Select a service.
3. Inthe Actions column, select View > Logs.
The service logs view is displayed with the Realtime tab open.
4. Click the Historical tab.

A list of historical logs for the selected service is displayed.

RSA| RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN

Services Cvent Sources  Health & Wellness

& Change Service | B nwappliance13731-Broker |  Logs ©

v Keyw Broker v | Search 2 Export

Timestamp Leve Message

5. Using supplied value 5.

jsing supplied value 100000.

Displaying 301 - 350 of 350

R'S/\ NETWITNESS  PLATFORM

Search Log Entries

To search the results shown in the Historical tab:

1. (Optional) Select a Start Date and End Date. Optionally, select a Start Time and End Time.

2. (Optional) For system and service logs, select a Log Level and a Keyword, or both. System logs
have seven log levels. Service logs have only six log levels because they do not include the TRACE
level. The default is ALL log entries.

3. (Optional) For service logs, select the Service: host or service.
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4. Click Search.
The view is refreshed with the most recent 10 entries matching your filter. As new matching log

entries become available, the view is updated to show those entries.

Show Details of a Log Entry

Each row of the Historical tab Log grid provides the summary information of a log entry. To display all
the details for a log message:

1. Double-click a log entry.

The Log Message dialog, which contains the Timestamp, Logger Name, Thread, Level and
Message, is displayed.

Log Mes=sage

Timestamp 201 7-06-22T07:47:12.000
Logeer Mame Engine

Thread

Level ALDIT

Meszage Uzer escalateduser (zeszion 343, :35328) has logeed
out

2. After viewing, click Close.

The dialog closes.

Page Through Log Entries
To peruse the different pages of the grid, use the paging controls on the bottom of the grid as follows:
« Use the navigation buttons

o Manually type the page number you want to view, and press ENTER.

Export a Log File

To export the logs in the current view:

Click Export, and select one of the drop-down options: CSV Format or Tab Delimited.

The file is downloaded with a filename that identifies the log type and the field delimiter. For example,
a NetWitness Platform system log exported with comma-separated values is named UAP _log_export
CSV.txt, and a host log exported with tab-separated values is named APPLIANCE _log_export_
TAB.txt.
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Maintaining Queries Using URL Integration

A URL integration provides a way to represent the bread crumbs, or query path, you take when actively
investigating a service in the Navigate view. You do not need to display and edit these objects often.

A URL integration maps a unique ID that is automatically created each time you click on a navigation
link in the Navigation view to drill into data. When the drill-down completes, the URL reflects the query
IDs for the current drill point. The Display Name is displayed in the bread crumb in the Navigate view.

The URL Integration panel provides a list of queries and allows users who have the proper permissions
to modify this underlying source of data and analyze the query patterns of other users of the NetWitness
Platform system. Within the panel, you can:

o Refresh the list.

o Edit a query.

o Delete a query.

o Clear all queries in the list.

Caution: After a query has been removed from the system, any Investigation URLs that included the
ID of that query will no longer function.

Edit a Query

1. Goto ADMIN > System.

2. In the options panel, select URL Integration.

URL Integration

= 4 | Orefresh & Clear

O i Display Name Query Username When Created ~

O o nwappliance11630 did = ‘'nwappliance11639% admin Tue Jul 11 2017 06:40:09 +00:00 (UTC)
O 1 threst.category = 'spe...  threat.category = "spectrum’ admin Tue Jul 11 2017 08:35:33 +00:00 (UTC)
0 z content = 'specrum.c. content = 'spectrum,consume’ admin Tue Jul 11 2017 08:41:33 +00:00 (UTC)
0 s content = 'specrum.a..  Content = 'specrum.analyze’ admin Tue Jul 11 2017 08:46:09 +00:00 (UTC)
O 4 gwu.edu domain.dst = "gwu.edu’ admin Tue Jul 11 2017 09:37:28 +00:00 (UTC)
O s 10.100.33.1 ip.sre=10.100.33.1 admin Wed Jul 12 2017 02:48:56 +00:00 (UTC)
[ ip.src="127.0.0.7 ipsrc=127.0.0.1 admin Wed Jul 12 2017 09:33:24 +00:00 (UTC)
[ tep.sreport = 54004 tep.sreport = 54004 admin Wed Jul 12 2017 08:37:44 +00:00 (UTC)
[l s nwappliance23912 did = ‘nwappliance23912° admin Wed Jul 12 2017 11:09:05 +00:00 (UTC)
(] gwu.edu domain.src ="gwu.edu’ admin Thu Jul 13 2017 13:58:52 +00:00 (UTC)
O 10 COTHER service =0 admin Fri Jul 14 2017 04:5&:50 +00:00 (UTC)
O test dam alert = 'test dom’ admin Fri Jul 14 2017 08:55:43 +00:00 (UTC)

| Page |1 of1 | | C Displaying 1-12 of 12
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3. Select the row in the grid and either double-click the row or click 3

The Edit Query Dialog is displayed.

Display Mame

Query

content = 'spectrum.consume’

content = 'spectrum.consume’

Cancel

Save

4. Edit the Display Name and the Query, but do not leave either field blank.

5. To save the changes, click Save.

Delete a Query

Caution: After a query has been removed from the system, any Investigation URLs that included the
ID of that query will no longer function.

To remove a query from NetWitness Platform entirely:

1. Select the query.

2. Click =

A dialog requests confirmation that you want to delete the query.

3. Click Yes.

Clear All Queries

To clear all queries from the list:

. Click & Clear

The entire list is cleared.

Maintaining Queries Using URL Integration
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Use a Query in a URI

URL Integration facilitates integrations with third-party products by allowing a search against the
NetWitness Platform architecture. By using a query in a URI, you can pivot directly from any product
that allows custom links, into a specific drill point in the Investigation view in NetWitness Platform.

The format for entering a URI using a URL-encoded query is:

http://<nw host:port>/investigation/<serviceld>/navigate/query/<encoded query>/date/<start

date>/<enddate>

where

o <nw host: port>is the IP address or DNS, with or without a port, as appropriate (ssl or not).
This designation is only needed if access is configured over a non-standard port through a
proxy.

o <serviceld> is the internal Service ID in the NetWitness Platform instance for the service to
query against. The service ID can be represented only as an integer. You can see the relevant
service ID from the url when accessing the investigation view within NetWitness Platform.

This value will change based on the service being connected to for analysis.

o <encoded query> is the URL-encoded NetWitness Platform query. The length of query is
limited by the HTML URL limitations.

o <start date> and <end date> define the date range for the query. The format is <yyyy-mm-
dd>T<hh:mm>. The start and end dates are required. Relative ranges (for example, Last Hour)

are not supported in this version. All times are run as UTC.

For example:
http://localhost:9191/investigation/12/navigate/query/alias % 20exists/date/2012-09-
01T00:00/2012-10-31T00:00

Examples

These are query examples where the NetWitness Server is 192.168.1.10 and the servicelD is identified
as 2.

All activity on 03/12/2013 between 5:00 and 6:00 AM with a hostname registered
o Custom Pivot: alias.host exists

o https://192.168.1.10/investigation/2...13-03-12T06:00

All activity on 3/12/2013 between 5:00 and 5:10 PM with http traffic to and from IP address
10.10.10.3
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o Custom Pivot: service=80 && (ip.src=10.10.10.3 || ip.dst=10.0.3.3)
o Encoded Pivot Dissected:

o service=80 => service&3D8&0

o ip.src=10.10.10.3 => ip%2Esrc%3D10%2E10%2E10%2E3

o ip.dst=10.10.10.3 => ip%2Esrc%3D10%2E10%2E10%2E3

o https://192.168.1.10/investigation/2...13-03-12T17:10

Additional Notes

Some values may not need to be encoded as part of the query. For example, commonly the IP src and dst

is used for this integration point. If leveraging a third-party application for integration of this feature, it is
possible to reference those without encoding applied.
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FIPS Support

NetWitness Platform 11.x ships with FIPS-validated 140-2 Cryptographic Modules that support all
cryptographic operations within NetWitness Platform. NetWitness Platform leverages two modules that
support a level 3 design assurance:

« RSA BSAFE Crypto-J

o OpenSSL with BSAFE (OWB)

Both modules have been certified with an operational environment comparable to the standard
NetWitness Platform configuration.

By default, the cryptographic modules enforce the usage of FIPS-certified cipher suites wherever
possible. For exceptions, refer to the information below and to the release notes. For additional
information about the FIPS modules, see http://csrc.nist.gov/groups/STM/cmvp/documents/140-1/140val-
all.htm.

The RSA BSAFE Crtypo-J FIPS Certificate number is 2468 and the OWB FIPS Certificate is included
in the RSA BSAFE Crypto-C Micro Edition with certificate number 2300.

In 11.x, FIPS is enabled on all services except Log Collector. This includes Log Decoder and Decoder if
they were FIPS-enabled in 10.6.x or any previous version. FIPS cannot be disabled on any services
except for Log Collector, Log Decoder and Decoder.

Note: For a fresh installation of 11.x, by default, all core services will be FIPS enforced except Log
Collector and Log Decoder. FIPS cannot be disabled on any services except for Log Collector, Log
Decoder and Network Decoder.

Note: For upgrades to 11.x from previous versions, the following conditions apply for the Log
Collector, Log Decoder and Decoder services:

- Log Collector is not FIPS enabled after upgrading to 11.x, even if FIPS was enabled in a previous
version. You must enable FIPS support after upgrading to 11.x. See the instructions in FIPS support for
Log Collectors.

- If FIPS was enabled for the Log Decoder and Network Decoder services in a prevous version, FIPS
will also be enabled in 11.x. However, if Log Decoder and Network Decoder were NOT FIPS
enabled in a previous version, they will not be enabled in 11.x, and you can manually enable FIPS for
these services if required. See the instructions in FIPS support for Log Decoders and Decoders.

73 FIPS Support


http://csrc.nist.gov/groups/STM/cmvp/documents/140-1/140val-all.htm
http://csrc.nist.gov/groups/STM/cmvp/documents/140-1/140val-all.htm

System Maintenance Guide

FIPS support for Log Collectors

To enable FIPS for Log Collectors:

1.

2.

Stop the Log Collector service.

Open the /etc/systemd/system/nwlogcollector.service.d/nwlogcollector-opts-

managed.conf file.

Change the value of the following variable to off as described here:
Environment="OWB ALLOW NON FIPS=on"
to

Environment="OWB ALLOW NON FIPS=off"

Reload the system daemon by running the following command:

systemctl daemon-reload
Restart the Log Collector service.

Set the FIPS mode for the Log Collector service in the Ul :

Note: This step is not required if you are upgrading from 10.6.x to 11.x and FIPS was enabled in
10.6.x.

a. Goto ADMIN > Services.
b. Select the Log Collector service and go to View > Config.

c. In SSL FIPS Mode, select the checkbox under Config Value and click Apply.

FIPS support for Log Decoders and Decoders

To enable FIPS for Log Decoders and Decoders that did not have FIPS enabled in 10.6.x:

L.
2.

Go to ADMIN > Services and select a Log Decoder or Network Decoder service.

Select View > Config, and in System Configuration, enable SSL. FIPS Mode by selecting the

check box in the Config Value column.
Restart the service.

Click Apply.

FIPS Support
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Troubleshoot NetWitness Platform

For information about troubleshooting NetWitness Platform, see the following topics:

Debugging Information

o Error Notification

« Miscellancous Tips

o NwLogPlayer

o Troubleshoot Feeds

Debugging Information

NetWitness Platform Log Files

The following files contain NetWitness Platform log information.

o

rabbitmq /var/log/rabbitmg/nw(@]localhost.log
/var/log/rabbitmg/nw(@localhost-sasl.log

collectd /var/log/messages
nwlogcollector /var/log/messages
nwlogdecoder /var/log/messages

sms /opt/rsa/sms/wrapper.log

sms /opt/rsa/sms/logs/sms.log

sms /opt/rsa/sms/logs/audit/audit.log

NetWitness Platform /var/lib/netwitness/uax/logs/nw.log
NetWitness Platform /var/lib/netwitness/uax/logs/ audit/audit.log

NetWitness Platform /opt/rsa/jetty9/logs
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Files of Interest

The following files are used in key NetWitness Platform components, and can be useful when trying to
track down miscellaneous issues.

I N

RabbitMQ configuration file. This

configuration file partially drives the
rabbit /etc/rabbitmg/rabbitmq.config

behavior of RabbitMQ, particularly around

network/SSL settings.

RabbitMQ environment configuration file.

This file specifies the RabbitMQ node
rabbit /etc/rabbitmg/rabbitmg-env.conf

name and location of the enabled plugins

file.

This file specifies the list of enabled
plugins in RabbitMQ. This file is managed
by the RabbitMQ server, via the rabbitmg-

rabbit /etc/rabbitmg/rsa_enabled plugins plugins command. This file overrides the
/etc/rabbitmg/enabled plugins path, in order
to work around issues with upgrading the

Log Collector from early versions.

The RabbitMQ trust store. This file
contains a sequence of PEM-encoded
) ) X.509 certificates, represented trust CAs.
rabbit /etc/rabbitmq/ssl/truststore.pem ) )
Any clients that connect to RabbitMQ and
present a certificate that is signed by a CA

in this list is considered a trusted client.
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T S

The RabbitMQ Mnesia directory. Mnesia is
the Erlang/OTP database technology, for

storing Erlang objects persistently.
RabbitMQ uses this technology for storing
information such as the current set of
policies, persistent exchanges and queues,

and so forth.

Importantly, the msg_store persistent and

msg_store transient directories are where
rabbit /var/log/rabbitmg/mnesia/nw@localhost RabbitMQ stores messages that have been
spooled to disk, e.g., if messages are
published as persistent messages, or which
have paged off to disk due to memory
limitations. Keep a close eye on this

directory, if the disk or memory alarms

have tripped in RabbitMQ.

Caution: Do not delete these files
manually. Use RabbitMQ tools to purge
or delete queues. Modifying these files
manually may render your RabbitMQ
instance inoperable.

Error Notification

NetWitness Platform has a set of error message types associated with different components and
operations. NetWitness Platform displays feedback in the form of a simple error notification and a log
entry.

When an error notification dialog is displayed, you have two options: simply acknowledge the message
or view the system log for more information.
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B3 Trial License Expired

If you want to view the system log for more information when an error notification is displayed, click
View log. The log opens in the ADMIN > System view with a list of messages. Timestamp and
message level are also listed.

RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Hosts  Services Event Sources Health & Wellness  System  Security

itz System Logging
Updates
Realtime Historical Settings
Licensing
ALL v ||Keywords Search
Email
Timestamp v Level Message

Global Notifications
2018-07-12T04:30:50.861  INFO Valid entitlements not found for service Broker - Broker

Lezacylflotiications 2018-07-12T04:30:50.863  INFO Looking for valid entitlements for service ESASecondary - Event Stream Analysis
| system Logging 2018-07-12T04:30:50.863  INFO  Valid entitlements not found for service ESASecondary - Event Stream Analysis

Global Auditing 2018-07-12T04:30:50.865  INFO Looking for valid entitlements for service Malware - Malware Analytics

Jobs 2018-07-12T04:30:50.865  INFO Valid entitlements not found for service Malware - Malware Analytics

2018-07-12T04:30:50.867  INFO Looking for valid entitlements for service Concentrator - Concentrator
Live Services
2018-07-12T04:30:50.867  INFO Valid entitlements not found for service Concentrator - Concentrator

URL Integration 2018-07-12T04:30:50.869  INFO Looking for valid entitlements for service Decoder - Decoder
Context Menu Actions 2018-07-12T04:30:50.869  INFO Valid entitlements not found for service Decoder - Decoder
Investigation 2018-07-12T04:30:50.907  INFO Sending License snapshot information to SMS service

ESA Analytics <

Miscellaneous Tips

Audit Log Messages

It can be useful to see which user actions result in which log message types in the /var/log/messages
file.

The event categories spreadsheet included in the log parser package in the NetWitness Platform Parser
v2.0.zip archive lists the event categories and the event parser lines to help with building reports, alerts,
and queries.

NwConsole for Health & Wellness

RSA has added a command option called logParse in NwConsole. This command option supports log
parsing, a convenient way to check log parser without setting up the full system to do log parse. For more
information about the logParse command, at the command line, type help logParse.
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Thick Client Error: remote content device entry not found

Error: “The remote content device entry was not found,” generated for a correlation rule applied to a
concentrator.

Problem: in Investigation, if you click the correlation-rule-name meta value in the Alert meta
key, you do not get session information.

Solution: Instead of using correlation rules on decoders and concentrators, use ESA rules. The ESA
rules do record the correlation sessions that match the ESA rule.

View Example Parsers

Since flex and lua parsers are encrypted when they are delivered by Live, you cannot easily view their
contents.

However, some plain text examples are available here: https://community.emc.com/docs/DOC-41108.

Configure WinRM Event Sources

The following Inside EMC article has a video that walks through the process of setting up Windows RM
(Remote Management) collection: https://inside.emc.com/docs/DOC-122732.

Additionally, it contains two scripts that are shortcuts for procedures described in the "Windows Event
Source Configuration Guide."

NwLogPlayer

NwLogPlayer is a utility that simulates syslog traffic. In the hosted environment, NwLogPlayer.exe is
a command line utility located on the RSA NetWitness® Platform Client machine in the following
directory:

C:\Program Files\NetWitness\NetWitness 9.8

NwLogPlayer is also located on the Log Decoder host in /usr/bin.

Usage

At the command line, type nwlogplayer.exe -h to list the available options, as reproduced here:

--priority arg set log priority level

-h [ --help ] show this message

-f [ --file ] arg input message; defaults to stdin
(=stdin)

-d [dir ] arg input directory
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-s [ --server ] arg remote server; defaults to localhost
(=localhost)

-p [ --port ] arg remote port; defaults to 514
(=514)

-r [ --raw ] arg Determines raw mode.

(=0)

o 0= add priority mark (default)
o 1=File contents will be copied line by line to the server.
o 3 =auto detect
o 4 =-enVision stream
o 5 =binary object
-m [ --memory ] arg Speed test mode. Read up to 1 Megabyte of messages from the file content

and replays.

--rate arg Number of events per second. This argument has no effect if rate >

eps that the program can achieve in continuous mode.

—-maxcnt arg maximum number of messages to be sent

-¢ [ --multiconn ]  multiple connection

-t [ --time ] arg simulate time stamp time; format is yyyy-m-d-hh:mm:ss
-v [ --verbose ] If true, output is verbose

--ip arg simulate an IP tag

--ssl use SSL to connect

--certdir arg OpenSSL certificate authority directory

--clientcert arg use this PEM-encoded SSL client certificate

-—udp send in UDP
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Troubleshoot Feeds

Overview

The purpose of the feed generator is to generate a mapping of an event source to the list of groups to
which it belongs.

If you have an event source from which you are collecting messages, and yet it is not displayed in the
correct event source groups, then this topic provides background and information to help you track down
the problem.

Details

The ESM Feed maps multiple keys to single value. It maps the DeviceAddress, Forwarder,
and DeviceType attributes to groupName.

The purpose of the ESM feed is to enrich event source Meta with the groupName collected on the Log
Decoder.

How it Works

The feed generator is scheduled to update every minute. However, it is triggered only if there are any
changes (create, update, or delete) in event sources or groups.

It generates a single feed file with event source to group mapping, and pushes the same feed to all of the
Log Decoders that are connected to NetWitness Platform.

Once the feed file is uploaded on the Log Decoders, for any new events, it enriches events Meta data
with groupName, and appends this groupName to logstats.

Once the groupName is in logstats, the ESM Aggregator groups information and sends it to ESM. At this
point, you should see the Group Name column under the Event Source Monitoring tab.

The entire process can take some time. Therefore, you may need to wait for several seconds after you
add a new group or event source, before the Group name is displayed.

Note: If the event source type attribute changes when the feed is updated, NetWitness Platform adds a
new logstats entry, rather than updating the existing one. Thus, there will be two different logstats
entries in logdecoder. Previously existing messages would have been listed under the previous type,
and all new messages are logged for the new event source type.

Feed File

The format of the feed file is as follows:

DeviceAddress, Forwarder, DeviceType, GroupName

The DeviceAddress is either ipv4, ipvé, or hostname, depending on which of these have been
defined for the event source.

The following is a sample of the feed file:
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"12.12.12.12","d6e", "NETFLOW", "grpl"

"12.12.12.12","1d4", "netflow", "grpl"

"12.12.12.12","de6e", "netfow", "grpl"
"0:E:507:E6:D4DB:E:59C:A","10.25.50.243", "apache", "Apachegrp"
"1.2.3.4","LCC", "apache", "Apachegrp"
"10.100.33.234","LC1", "apache", "Apachegrp"
"10.25.50.248","10.25.50.242","apache", "Apachegrp"
"10.25.50.251","10.25.50.241", "apache", "Apachegrp"
"10.25.50.252","10.25.50.255", "apache", "Apachegrp"
"10.25.50.253","10.25.50.251", "apache", "Apachegrp"
"10.25.50.254","10.25.50.230", "apache", "Apachegrp"
"10.25.50.255","10.25.50.254", "apache", "Apachegrp"
"13.13.13.13","LC1", "apache", "Apachegrp"
"AB:F255:9:8:6C88:EEC:44CE:7",, "apache", "Apachegrp"
"Appliancel234",,"apache", "Apachegrp"
"CB:F255:9:8:6C88:EEC:44CE:7","10.25.50.253", "apache", "Apachegrp"

Troubleshooting

You can check the following items to narrow down where the problem is occurring.

Feed File Existence

Verify that the feeds ZIP archive exists in the following location:

/opt/rsa/sms/esmfeed.zip
Do not moditfy this file.
Group Meta Populated on LD

Verify that the group meta is populated on the Log Decoder. Navigate to the Log Decoder REST and
check logstats:

http://LogDecoderIP:50102/decoder?msg=logStats&force-content-type=text/plain

This is a sample logstats file with group information:

device=apache forwarder=NWAPPLIANCE10304 source=1.2.3.4 count=338
lastSeenTime=2015-Feb-04 22:30:19 lastUpdatedTime=2015-Feb-04 22:30:19
groups=IP1234Group, apacheGroup

device=apachetomcat forwarder=NWAPPLIANCE10304 source=5.6.7.8 count=1301
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lastSeenTime=2015-Feb-04 22:30:19 lastUpdatedTime=2015-Feb-04 22:30:19

groups=AllOtherGroup,ApacheTomcatGroup
In the above text, the group information is bold.

Device Group Meta on Concentrator
Verify that the Device Group meta exists on the Concentrator, and that events have values for the
device.group field.

Device Group (8 values) L
testgroup (28.878) - localgroup (3.347) - squid (3.346) - allothergroup (780) - apachetomcatgroup (561) - ip1234dgroup (457) - cacheflowelff(219) - apachegroup (91)

sessionid = 22133

time = 2015-02-05T14:35:03.0
size = o

le.cid = "NWAPPLIANCE10304" =~
forward.ip = 127.0.0.1

device.ip = 20.20.20.20 ~

medium = 32

device.type = "unknown" =

device.group "TestGroup”

kig_thread

"r

SMS Log File

Check the SMS log file in the following location to view informational and error messages:
/opt/rsa/sms/logs/sms.log

The following are example informational messages:

Feed generator triggered...
Created CSV feed file.
Created zip feed file.

Pushed ESM Feed to LogDeocder : <logdecoder IP>

The following are example error messages:

Error creating CSV File : <reason>Unable to push the ESM Feed: Unable to
create feed zip archive.

Failed to add Group in CSV: GroupName: <groupName> : Error: <error>

Unable to push the ESM Feed: CSV file is empty, make sure you have al-least on
group with al-least one eventsource.

Unable to push the ESM Feed: No LogDecoders found.
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Unable to push the ESM Feed: Unable to push feed file on LogDecoder-
<logdecoderIP>Unable to push the ESM Feed:
admin@<logdecoderIP>:50002/decoder/parsers received error: The zip archive
"/etc/netwitness/ng/upload/<esmfeedfileName>.zip" could not be opened

Unable to push the ESM Feed: <reason>

Verify Logstats data is getting Read & Published by ESMReader & ESMAggregator
These are the steps to verify that logstats are collected by collectd and published to Event Source
Management.

ESMReader
1. On LogDecoders add debug "true' flag in /etc/collectd.d/NwLogDecoder_ESM.conf:

#
# Copyright (c) 2014 RSA The Security Division of EMC
#
<Plugin generic cpp> PluginModulePath "/usr/lib64/collectd"
debug "true"
<Module "NgEsmReader" "all"> port "56002"

ssl "yes"

keypath "/var/lib/puppet/ssl/private keys/d4c6dcd4-6737-4838-
azf7-ba7e%albbaae.pem"

certpath "/var/lib/puppet/ssl/certs/d4c6dcd4-6737-4838-a2f7-
ba7e9%al65aae.pem"

interval "600"

query "all"

<stats></stats></Module><Module "NgEsmReader" "update"> port
"56002" ssl "yes"

keypath "/var/lib/puppet/ssl/private keys/d4c6dcd4-6737-4838-
azf7-ba7e%albbaae.pem"

certpath "/var/lib/puppet/ssl/certs/d4c6dcd4-6737-4838-a2f7-
ba7e9%al65aae.pemn"

interval "60"

query "update"

<stats></stats></Module></Plugin>

2. Run the command:

collectd service restart

Troubleshoot NetWitness Platform

84



System Maintenance Guide

3. Run the following command:
tail -f /var/log/messages | grep collectd
Verify that ESMReader is reading logstats and there are no errors. If there are any read issues, you

will see errors similar to the following:

Apr 29 18:47:45 NWAPPLIANCE15788 collectd[14569]: DEBUG: NgEsmReader all:
error getting ESM data for field "groups" from logstat device=checkpointfwl
forwarder=PSRTEST source=1.11.51.212. Reason: <reason>Apr 29 18:58:36
NWAPPLIANCE15788 collectd[14569]: DEBUG: NgEsmReader update: error getting ESM
data for field "forwarder" from logstat device=apachetomcat

source=10.31.204.240. Reason: <reason>

ESMAggregator

1. On NetWitness Platform, uncomment the verbose flag in /etc/collectd.d/ESMAggregator.conf:

# ESMAggregator module collectd.conf configuration file

#

# Copyright (c) 2014 RSA The Security Divsion of EMC

#

<Plugin generic_cpp> PluginModulePath "/usr/lib64/collectd"

<Module "ESMAggregator">
verbose 1
interval "eQ"
cache save interval "600"
persistence dir "/var/lib/netwitness/collectd"

</Module> </Plugin>
2. Run the following:
collectd service restart

3. Run the following command:
run “tail -f /var/log/messages | grep ESMA
Look for for ESMAggregator data and make sure your logstat entry is available in logs.

Sample output:

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[O]
logdecoder[0] = d4c6dcd4-6737-4838-a2f7-ba7e%al6b5aae
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Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[l]
logdecoder utcLastUpdate[0] = 1425174451

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[2]
groups = Cacheflowelff,Mixed

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[3]
logdecoders = d4c6dcd4-6737-4838-a2f7-ba7e%al65aae

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[4]
utcLastUpdate = 1425174451

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: Dispatching
ESM stat NWAPPLIANCE15788/esma update-cacheflowelff/esm counter-3.3.3.3 with a
value of 1752 for NWAPPLIANCE15788/cacheflowelff/esm counter-3.3.3.3
aggregated from 1 log decoders

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[O]
logdecoder[0] = 767354a8-5e84-4317-bc6a-52e4f4d8bfff

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[l]
logdecoder utcLastUpdate[0] = 1425174470

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[2]
groups = Cacheflowelff,Mixed

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[3]
logdecoders = 767354a8-5e84-4317-bc6a-52e4f4d8bfff

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[4]
utcLastUpdate = 1425174470

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: Dispatching
RRD stat NWAPPLIANCE15788/esma_ rrd-cacheflowelff/esm counter-3.3.3.3 with a
value of 1752 for NWAPPLIANCE15788/cacheflowelff/esm counter-3.3.3.3

aggregated from 1 log

Configure JMX Feed Generator Job Interval

Although the feed generation job is scheduled to execute every minute by default, you can change this by
using jconsole, if necessary.

To change the feed generator job interval:
1. Open jconsole for the SMS service.
2. On the MBeans tab, navigate to com.rsa.netwitness.sms > API > esmConfiguration > Attributes.

3. Modify the value for the property FeedGeneratorJobIntervallnMinutes.
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4. Go to Operations under the same navigation tree, an click commit(). This persists the new value in

the corresponding json file under /opt/rsa/sms/conf, and uses the value if SMS is restarted.

Setting a new value reschedules the feed generator job for the new interval.
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References

This section describes the NetWitness Platform user interface views in which you can perform system
maintenance tasks. You use this interface to:

o Monitor and maintain services (settings, statistics, command and message syntax, REST API, RSA

Console utility, and protocols supported in NetWitness Platform).
o Display the current NetWitness Platform version and license status.
o Manage your Local Update Repository from which you apply software version updates to hosts.

The following topics describe each interface in detail:

o Health and Wellness View

o System View - System Info Panel
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Health and Wellness View

The Health and Wellness settings allow you to set and view alarms, monitor events, and view policies
and system statistics. For more details on each of these, see the following topics:

o Health and Wellness View - Alarms View

« Event Source Monitoring View

o Health and Wellness Historical Graphs

o Health and Wellness Settings View - Archiver

o Health and Wellness Settings View - Event Sources

o Health and Wellness Settings View - Warehouse Connector

o Monitoring View

o Policies View

o System Stats Browser View
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Health and Wellness View - Alarms View

You can monitor hosts and services to determine when user-defined limitations have been reached by
viewing all the active alarms. Policy rules, that you define or assign to hosts and services, in the Policies
tab trigger these alarms. You can:

o View all the alarms that are currently active for all your systems and services

o Select an alarm and view its details

What do you want to do?

Administrator View the alarm status of NetWitness Monitor Alarms

Servers and services.

Administrator ~ View detailed information about a specific Monitor Alarms

alarm.

Related Topics

Manage Policies

Quick Look

The required permission to access this view is Manage services. To access the Alarms view, go to
Admin > Health & Wellness. The Health & Wellness view opens with the Alarms tab displayed. The
Alarms tab contains an alarms list and an Alarm Details panel.
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HEALTH & WELLNESS

Polidies System Stats Browser  Event Source Monitoring

L] e o

Time Stane

W Agdress

S| ey

lvems 1- 24 0f 24

[R'S /\ NETWITNESS  PLATFORM

Time when the alarm was triggered.
A Status of the alarm:
o Active - the statistical threshold was crossed triggering the alarm.
o Cleared - the clearing threshold was crossed and the alarm is no longer active.
RIN Scverity assigned to this alarm:
o Critical
« High
¢ Medium
o Low
Name of the rule that triggers the alarm.
Service defined in the rule.
n Host on which the alarm is triggered.
Statistic selected in the rule that triggers the alarm.
n Value of the statistic that triggered the alarm.
n Identification number of the alarm.
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Note: NetWitness Platform sorts the alarms in time order. You can sort the relevant parameters in
ascending or descending order.

This figure shows the Alarms tab with the Alarm Details panel expanded.

HEALTH & WELLNESS

Polices System Stats Browser  EventSource Monitoring  Settings

Alarm Details
Time - stane severty | RuleName

¥ 2017-06-22 11:09:1TAM  Active @ Critical Convexthub Server i T

ACTIVE

Contexthul Server

Contexthul Serser

The Contexthub Sen

detgrming the izsus

ssiconcexchub-server! for proper operation.

Brocessinio! Oy

ERAOR
1

S0-505 34560

| Page 1 of 1 | | C [+ Aums Refresh lnes

R S/\ NETWITNESS' PLATFORM

Alarm Details Panel

The Alarm Details panel displays information for the alarm selected in the Alarms list. It contains all the
information in the Alarms list plus the following fields.

- Suppression end time

Suppression start (selected time zone)
Suppression end (selected time zone)

n The Policy ID
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Event Source Monitoring View

Note: To manage Event Sources, see "About Event Source Management" in the NetWitness Platform
Event Source Management Guide.

NetWitness Platform provides a way to monitor the statistics for various event sources in the User
Interface. The information displayed is historical and comes from the Log decoder. You can customize
the view depending on the parameter you select to filter the data.

To access the Event Source Monitoring view:

1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.

2. Click Event Source Monitoring.

What do you want to do?

Administrator View the Events Collected from an  Historical Graph View for Events Collected

Event Source from an Event Source

Related Topics

« Monitor Event Sources

o Filter Event Sources

o View Historical Graph of Events Collected for an Event Source

Quick Look

The Event Source Monitoring view is displayed.
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Alarms

Monitoring

GATE

Policies

MONITOR

CONFIGURE

System Stats Browser

ADMIN

Event Source Monitoring

Settings

NWAPPLIANCE11639

cacheflowelff
ciscoasa
netwitnessspectrum

winevent_snare

NWAPPLIANCE11639
NWAPPLIANCE11639
NWAPPLIANCE11639

NWAPPLIANCE11639

NWAPPLIANCE11639

NWAPPLIANCE11639

NWAPPLIANCE11639

NWAPPLIANCE11639

1"
96
2

2 days, 2 hours, 14 min

2 days, 5 hours,
2 days, 5 hours, 52 min

3 days, 2 hours, 50 min

2017-07-
2017-07-
2017-071

2017-07-1

1211:36:58 A...

Event Source Event Source Type Log Collector Log Decoder Time Frame Order By *——

Any v Any ~ Ay ~ | Any v Any M| Apply Clear Export as CSV
DRegex ®Received (_Not Received ®)Ascending (_)Descending
Event Source Event Source Type Log Collector Log Decoder Count Idle Time Last Collected Time Historical Graph

W
W
P

W

| Page 1

of1 |

| C

Iltems 1 -40f4

R'S/\ NETWITNESS  PLATFORM

Displays Event Source Monitoring tab.

Toolbar used to filter and customize the Event Source Monitoring tab.
Displays Event Source Stats panel.

Filters

This table lists the various parameters you can use to filter and customize the event source monitoring

view.

Parameter

Event

Source

Event

Source Type

Log

Collector

Description

Type the name of an event source you want to monitor.

Select Regex to enable Regex filter. It performs a regular expression search against

text and lists out the specified category. If Regex is not selected it supports globbing

pattern matching.

Select an event source type for the event source selected.

Select the Log Collector to display the data collected by the specified Log Collector.
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Log Decoder

Time Frame

Order By

Apply
Clear

Export as

CSv

Select a Log Decoder to display the data collected by the specified Log Decoder.

Select the time frame for which you want the stats.

Select Received if you need the query results to contain only event sources that logs
have been received from within the selected time.

or

Select Not Received if you need the query results to contain only event sources that

logs have not been received from within the selected time

Select the order in which the list needs to be filtered.

Select Ascending to filter it in an ascending order.
Click to apply the filters chosen and display the list accordingly.
Click to clear the chosen filters.

Click to export the information as a csv file.

Event Source Stats View Display

Event Source

Event Source

Type
Log Collector
Log Decoder

Count

Idle Time

Displays the name of the event source.

Displays the event source type.

Displays the Log Collector from where the events were initially captured.
Displays the Log Decoder where the events are being processed.

Displays the number of events received by Log Decoder since last reset of count

value.

Displays the time lapsed after the last stat collection.
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Last Collected Displays the time at which the Log Decoder last processed an event for the event

Time source

Historical Graph ~ Click i to view the historical graph of the stats collected for the event source.
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Health and Wellness Historical Graphs

Configuring the Archiver monitoring enables you to automatically generate notification when critical
thresholds concerning Archiver aggregation and storage have been met. The Historical Graph view
provides a visualization of historical data.

Note: Historical graphs are not available for non-numeric statistics, and is indicated by a greyed out
icon.

See the following topics for more details:

o Historical Graph View for Events Collected from an Event Source

« Historical Graph for System Stats

Historical Graph View for Events Collected from an Event Source

The Historical Graph view for events collected from an event source provides a visualization of
historical data. To access this view:

1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Monitoring tab open.
2. Click Event Source Monitoring.

The Event Source Monitoring view is displayed.

3. In the Historical Graph column, select b

The Historical graph for the selected event source type is displayed in a popup window.
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The figure displays the events collected from the event source type winevent_snare.

Historical Graph

winevent_snare: 18 86 S8 0 Time Frame Current Day v
Zoom 1h 6h 12h 1d Al From | Jul 9, 2017 To | Jul 10,2017
0.0075
0.005 O
b
0.0025
: :
21:00 10. Jul 03:00 06:00 09:00 12:00 15:00 18:00
Al ]
10. Jul 06:00 2 1300
‘ il | 3
— average
Click and drag in the plot area to zoom in

You can customize the graph as required. The table lists the various parameters used to customize the
historical graph.

Time Frame  Select the Time Frame for which you want to view the historical data. The available

options are: Current Day, Current, Week, Current Month.

From <date> Select the date range for which you want to view the historical data.

To <date>

You can zoom in for a detailed view of the data in the Historical graph.
Zoom In Function 1 and 2

You can select one of the values to view the historical data for the selected value. The figure below
displays an example for the 6h frame selected for zoom in. The slider bar at the right bottom corner is
also changed to a 6h window.

Alternatively, you can slide the bar in the right hand corner to zoom in to a required frame.
Zoom In Function 3

You can click and drag in the plot area to zoom in for a required frame of time.

Historical Graph for System Stats

To access the Historical Graph for the System Stats:
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1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.
2. Click the System Stats Browser tab.

The System Stats Browser tab is displayed.
3. In the Historical Graph column, select b

The Historical graph for the selected statistic for a host is displayed.

The figure displays the system stats view for the Memory Utilization statistics.

Historical Graph

Host: Memory Utilization Time Frame Current Day v
Zoom 1h 6h 12h 14 Al From | Jul 9, 2017 To | Jul 10, 2017
15.5
19
g
£
185 ®
18
17.5
21:00 10, Jul 03:00 06:00 0%9:00 12:00 15:00 18:00
10. Jul 06:00 /—""_’/]_FZZOO 8:00
‘ in '
—— average
Click and drag in the plot area to zoom in

Parameters

You can customize the graph view as required. The table lists the various parameters used to customize
the historical graph view.

Time Frame Select the time frame for which you want to view the historical data.
The available options are: Current Day, Current Week, Current Month, and

Current Year.

From <date> To Select the date range for which you want to view the historical data,

<date>

You can zoom in for a detailed view of the data in the Historical graph.
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Zoom in function 1 and 2:

You can select one of the values to view the historical data for the selected value. The figure below
displays an example for the 6h frame selected for zoom in. The slider bar at the right bottom corner is
also changed to a 6h window.

Alternatively, you can slide the bar in the right hand corner to zoom in to a required frame.

Historical Graph

Host: Mounted Filesystem Disk Usage Percent Time Frame | Current Mom v
Zoom 1w 2w 3w Im All From | Jun 29, 2017 To | Jul 14, 2017
7
5.5
s §
E
mw
5.5
5
45
30. Jun 2. Jul 4 Jul 6. Jul 8. Jul 10. Jul 12, Jul 14, Jul
-
19. Jun 26. Jun 3. Ju 10 jull
] m »
average
Click and drag in the plot area to zoom in

Zoom in function 3:
You can click and drag in the plot area to zoom in for a required frame of time.

The figure below displays an example of how the graph appears while you click and drag.
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Host: Mounted Filesystem Disk Usage Percent
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Health and Wellness Settings View - Archiver

Note: To monitor Archiver and Warehouse Connector, see Health Policy.

To access the Archiver Monitoring view:

1. Go to Administration > Health & Wellness.

2. Select Settings > Archiver.

What do you want to do?

Administrator Monitor service details of Archiver Monitor Service Details

Quick Look

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Health &

Alarms  Monitoring ~ Policies  System Stats Browser  Event Source Monitoring [CSGIi

To monitor Event Sources, see Event Scurce Management. To monitor Archiver and Warehouse Connector, see Health Policy.

EventSource | Archiver, | Warehouse Connector
t _m
Archiver Monitoring D e |

These settings allow for notifications to be generated when critical thresholds concerning Archiver aggregation and
storage have been met.

Aggregation Status
Notify After ] v

For [l Failed [ offline

Aggregation Connection

Notify After Failing For £ |Minutes v

Storage Connection

Notify After Failing For C  Minutes v

Storage Capacity

Storage Threshold By Space Time

RS /\ NETWITNESS® PLATFORM

Bl Displays Archiver Monitoring Panel

P Configure Archiver Monitoring Panel to automatically receive notification

Features

The following table lists the parameters required to configure the Archiver to automatically generate
notification when critical thresholds are reached.
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Aggregation Notify After Number of minutes or hours after which the you will get notified
Status of the Aggregation status
For Failed - If enabled, you get notification when the

Archiver aggregation status is failed for the defined number of
minutes or hours.

Offline - If enabled, you get a notification when the

Archiver aggregation status is offline for the defined number of

minutes or hours

Aggregation Notify After Number of minutes or hours after which you will receive a
Connection  Failing for notification if the Archiver aggregation connection fails.
Storage Notify After Number of minutes or hours after which you will receive a
Connection  Failing for notification if the Archiver storage connection fails.
Storage Storage Threshold ~ Select Space, if you want to receive a notification when the

Archiver storage capacity exceeds the percentage defined in

Capacity By the When Storage Size Is field.

Select Time, if you want to receive a notification when the files
stored in the Archiver exceeds the defined number of days in
the When Oldest Storage File Is field

When Storage Size Enter what percent full the storage size should be if you want to
Is receive a notification.

When Warm Enter what percent full the warm storage size should be if want

. to receive a notification.
Storage Size Is
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Notification  Configure email or

Type distribution list

Configure Syslog
and SNMP Trap

SCrvers

NW Console,

Email,

Syslog Notification,
SNMP Trap

Notification

Click to configure email so that you can receive notifications in
NetWitness Platform.

Click to configure audit logs.

Enable NW Console to get notifications on the NetWitness
Platform UI notification toolbar.

Enable Email to get email notifications.
Enable Syslog Notification to generate syslog events.

Enable SNMP Trap Notification to get audit events as SNMP
traps.
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Health and Wellness Settings View - Event Sources

Note: To manage Event Sources, see "About Event Source Management" in the RSA NetWitness
Platform Event Source Management Guide.

The Event Source Monitoring view consists of the Event Source panel, Add/Edit Source Monitor dialog,
Decommission panel, and the Decommission dialog. You use the view to configure:

o When to generate notifications for event sources from which the Log Collector is no longer receiving

logs.
o Where to send those notifications.
o When to decommission a Log Collector when a Remote Collector and the Local Collector fails over

to a standby Log Decoder.

The required role to access this view is Manage NW Auditing. To access this view:

1. Go to Admin > Health & Wellness.

2. Select Settings > Event Source.

What do you want to do?

Administrator ~ View the functionality of Event Source Monitoring Monitor Event Sources

Related Topics

Configure Event Source Monitoring
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Quick Look

The Event Source tab is displayed.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Hea ellness

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings

To monitor Event Sources, see Event Source Management. To monitor Archiver and Warehouse Connector, see Health Policy.

Event Source Archiver Warehouse Connector
|
Event Source Monitoring <+

These setting dictate when to generate notifications for event sources that the system is no longer receiving logs from and where to
send those notifications.

+

Regex  Source Type Source Host Time Threshold

Hours Minutes

RS /\ NETWITNESS’ PLATFORM

Displays Event Source Monitoring Panel

Al Configure Event Source Monitoring Panel to receive notification

Event Source Monitoring Panel

Description

Configure email or  Opens the Administration > System > Email view so you can adjust the email

distribution list. distribution for the Event Source Monitoring output, if necessary.

Configure Syslog Opens the Administration > System > Auditing view so you can adjust the
and SNMP Trap Syslog and SNMP trap distribution for the Event Source Monitoring output, if

SCTVers. necessary.

+ Displays the Add/Edit Source Monitor dialog in which you add or modify event

sources to monitor.

- Deletes the selected event sources from monitoring.

& Selects an event source.
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e o

Source Type Displays the source type of the event source.
Source Host Displays the source host of the event source.
Time Threshold Displays the time period after which NetWitness Platform stops sending

notifications (Time Threshold).

Apply Applies any additions, deletions, or changes and they become effective
immediately.
Cancel Cancels any additions, deletion, or changes.

Decommission Panel

Foawrs osscpton

+ Displays the Decommission dialog in which you add or modify event sources to
decommission.
- Deletes the selected event sources from decommissioning.
Selects an event source.
Regex Displays if you choose to use regular expressions

Source Type Displays the source type of the decommissioned event source.
Source Host  Displays the source host of the decommissioned event source.
Apply Applies any additions, deletions, or changes and they become effective immediately.

Cancel Cancels any additions, deletions, or changes.
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Add/Edit Source Monitor Dialog

Add/Edit Source Monitor

L] Regex

Source Type *

Source Host *

0 £ | Hours
Time Threshold *

0 $ Minutes

Cancel

In Add/Edit Source Monitor dialog, you add or modify the the event sources that you want to monitor.

The two parameters that identify an event source are Source Type and Source Host. You can

use globbing (pattern matching and wildcard characters) to specify the Source Type and Source Host of

event sources as shown in the following example:

Source
Type

ciscopix 1.1.1.1

ki 1.1.1.1

% %

ki 1.1.1.1]1.1.1.2

* 1.1.1.[1]2]

ki 1.1.1.]123]

* 1.1.1.[0-9]

ki 1.1.1.11[0-5]

® 1.1.1.1,1.1.1.2

ki 1.1.1.]0-9]|1.1.1.11]0-5]
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Source
Type

* 1.1.1.[0-9]|1.1.1.11]0-5],10.31.204.20
* 1.1.1.*
* 1.1.1.[0-9]{1,3}

Features

s Jowan

Regex Select the checkbox if you want to use regular expressions

Source Type  The source type of the event source. You must use the value that you
configured for the event source in the Event Sources tab of the
Administration > Services > Log Collector service > View > Config

View.

Source Host ~ Hostname or IP address of the event source. You must use the value that
you configured for the event source in the Event Sources tab of the

Administration > Services > Log Collector device > View > Config

view.
Time The time period after which NetWitness Platform starts sending
Threshold notifications.
Cancel Closes the dialog without adding the event source, or changes to the

event source, to the Event Source Monitoring panel.

OK Adds the event source to the Event Source Monitoring panel.

References 110



System Maintenance Guide

Decommission Dialog

Decommission

W Regex

Source Type *  apache

Source Host *

Cancel

m Description
Source The source type of the event source. You must use the value that you configured for the
Type event source in the Event Sources tab of the Administration > Services > Log Collector

device > View > Config view.

Source Hostname or IP address of the event source. You must use the value that you configured
Host for the event source in the Event Sources tab of the Administration > Services > Log

Collector service > View > Config view.

Cancel Closes the dialog without applying any event source additions, deletions, or changes to the

Decommissioning panel.

OK Applies any event source additions, deletions, or changes to the Decommissioning panel.
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Health and Wellness Settings View - Warehouse Connector

Note: To monitor Archiver and Warehouse Connector, see "Health Policy".

Configuring the Warehouse Connector monitoring enables you to automatically generate notification
when critical thresholds concerning Warehouse Connector and storage have been met.

Access the Warehouse Connector Monitoring view

1. Go to Admin > Health & Wellness.

2. Select Settings > Warehouse Connector.

What do you want to do?

Administrator  View the details of Warehouse connector Warehouse Connector Details View

Related topics

Monitor Service Details

Quick Look

The Warehouse Connector Monitoring view is displayed.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN (E

Health & Wellness

Alarms  Monitoring ~ Policies  System Stats Browser  Event Source Monitoring ISR

To monitor Event Sources, see Event Source Management. To monitor Archiver and Warehouse Connector, see Health Policy.

EventSource | Archiver | Warehouse Connector 1——

Warehouse Connector Monitoring «—H

These settings allow for notifications to be generated when critical thresholds concerning Warehouse Connector
and storage have been met.

Source or Destination Status

Notify Offline For ¢ |Minutes v
Stream Status

Notify Stopped For ¢ |Minutes v
Disk Is S % Full
Source Is Behind £ | Sessions
Rejected Folder Size Is S % Full

Number Of Files In Permanent
Failure Folder

Notification Type

onfigure email or distribution list

RS /\ NETWITNESS  PLATFORM

11.0.0.0-170824160200.1.64b133b

Displays Warehouse Connector Monitoring view Panel

Allows to configure Warehouse Connector Monitoring parameters
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Warehouse Connector Monitoring parameters

The following table lists the parameters required to configure the Warehouse Connector to automatically
generate notification when critical thresholds are reached.

Source or
Destination

Status

Notify Offline For

Stream Status Notify Stopped For

Disk Is

Source Is Behind

Rejected Folder Size
Is

Number Of Files in
Permanent Failure

Folder

Number of minutes or hours after which the you will receive

a notification if the source or destination connection fails.

Number of minutes or hours after which you would like to

receive a notification when the Stream goes offline.

The limit on the percentage of disk usage after which

you would like to receive a notification.

Number of sessions after which a notification is raised if the

source goes behind the defined number of sessions.

Limit on the percentage of folder usage after which you

would like to receive a notification.

Limit on the number of files in the permanent failure folder

after which you would like to receive a notification.

Notification  Configure email or Click to configure email so that you can receive notifications
Type distribution list in NetWitness Platform.
Configure Syslog and  Click to configure audit logs.
SNMP Trap servers
NW Console, Enable NW Console to get notifications on the NetWitness
Email, Platform UI notification toolbar.
Syslog Notification, Enable Email to get email notifications.
SNMP Trap Enable Syslog Notification to generate syslog events.
Notification Enable SNMP Trap Notification to get audit events as
SNMP traps.
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Monitoring View

NetWitness Platform provides detailed statistics and other information about the host and the individual
NetWitness Platform services on Details views. You can view the current health of all the hosts,
services running on the hosts, various aspects of the hosts’ health, host details and service details in the
Monitoring view.

To access this view:
1. Goto ADMIN > Health & Wellness.

2. Click the Monitoring tab.

What do you want to do?

Administrator View and Perform Procedures Monitor Hosts and Services

Quick Look

The Monitoring view is displayed.

CONFIGURE ADMIN

HEAL ESS

Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCE10604

Groups Hosts Filter
tame Souns Stopped Services Stopped Processing Physical Drive Problems Logical Drive Problems Full Filesystems
S @ [1] 4 0 host(s) 0 host(s) 1 host(s)
= Status: @ CPU: 0.78% Memory: 9.43 GB/31.42 GB :
Service Health Status ~ Rate Name Service Type cPU Memory Usage Uptime
® Ready ® EventStream Analysis  0.1% 5.45GB 1 day 4 hours 25 minutes
@ Ready ] Contexthub Server 0% 1.20GB 1 day 4 hours 25 minutes
® Ready ] tics Serve Entity Behavior Analyz.. 0% 645.89 MB 1 day 4 hours 25 minutes
B NWAPPLIANCE11639 Status: @ CPU: 1.36% Memory: 4.45 GB/31.42 GB
Service Health Status ~ Rate Name Service Type cPu Memory Usage Uptime
® Ready L] Log Collector 1.5% 54,28 MB 4 hours 40 minutes 2 sec,
® Ready 0 Log Decoder 2.5% 1.73GB 4 hours 40 minutes 2 sec.
" Moot o P PT™ aneaion PR Sy Y
| Page 1 of1 | | C Displaying 1 - 10 of 10

RS /\ NETWITNESS' PLATFORM

Displays Monitoring tab.
Group Panel to select a Group.

Hosts panel displays operational statistics.
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Groups Panel

The Groups panel lists all the groups of hosts available. When you select a group, the associated content
is displayed in the Hosts panel.

Note: If the total host Count in the Groups panel is lower than the actual number of hosts displayed in
the Hosts panel, please refer to the Troubleshooting Health & Wellness topic for possible causes of
this issue and recommended solutions.

Hosts Panel

The Hosts panel displays operational statistics for hosts and the services running on each host.

Filter

Stopped

Services

Stopped

Processing

Physical drive
Problems

<#> host(s)

Logical Drive
Problems

<#> host(s)

Full
Filesystems

<#> host(s)

Type @ host name or a service name in the Filter field to display the corresponding

hosts and services in the Host panel.

Click Stopped Services to display a list of all stopped services. It also displays the

host on which the service is installed.

Click Stopped Processing to display a list of all the hosts that have services installed

on them that are in the stopped processing status.

Click to view the hosts that have physical drive problems.

Click to view the hosts that have logical drive problems.

Click to view the hosts that have full file systems.

Note: The summary information in the boxes at the top displays the System Statistics for all the hosts
configured in NetWitness Platform and does not change with host of filters on groups.

The top panel is followed by a list of hosts, the services installed on them and information regarding the
hosts and services.

115

References



System Maintenance Guide

Host Name

Status

CPU

Memory

Displays the host name.

If a host has services installed you will see a E prefixed to the host

name.

Click £ to view all the services installed on the host.

Displays the status of the Host.
® - denotes that the host is active and running.

® - denotes that the host is stopped or yet to start processing.

Displays the current CPU usage of the host.

Displays the Memory used by the host.

When you click E prefixed to the host name, a list of all the services installed on the host is displayed.
The table below describes various parameters displayed for a service and their description.

Service

Health Status

Rate
Name
Service Type

CPU

Displays the status of the service.

@ Ready - denotes that the service is active and running.

® Stopped - denotes that the service is stopped or yet to start processing.

Displays the processing status of the Service.
@ - denotes that the process is running and the data is being processed at a rate

greater than zero.

® - denotes that the processing is stopped.
@ - denotes that the processing is turned on but the data is not being processed.

Denotes the rate at which the data is being processed.
Name of the service.
Name of the type of service.

Displays the current CPU usage of the service.
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Memory Displays the Memory used by the service.
Usage
Uptime Displays the time for which the service has been running.
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Archiver Details View

The Archiver Details view provides information about the Archiver. The following figure depicts the
Archiver Details.

RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Health

lness

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCE25988 @

TR Archiver Details

Host
Service

I Archiver

CcPU 0.2% Used Memory 32.98 MB
Running Since 2017-Jul-10 10:30:25 Max Process Memory 31.42GB
Build Date 2017-Jul-0907:24:34 Version Information
Details
Aggregation State stopped Time Begin
Session Free Pages 0 Time End
Meta Free Pages 0 Session Rate Max ]
Database Status Session Rate 0
Database Session Rate Database Session Free Space
Database Session Rate Max Database Session Volume Bytes

RS /\ NETWITNESS' PLATFORM

For the related procedure, see Monitor Service Details

This section displays the current generic statistics for the service.

Description

Aggregation  State of data aggregation.
State

Time Begin Time (UTC) when the first session was tracked by the index.

Session Free  Session pages available for aggregation.

Pages
Time End Time (UTC) when the last session was tracked by the index.

Meta Free Pages available for aggregation.
Pages

Session Rate Maximum sessions per second rate.

Max
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e o

Database
Status

Session Rate

Database

Session Rate

Database
Session Free

Space

Database
Session Rate

Max

Database
Session
Volume

Bytes

Status of databases. Valid values are:

o closed - not available for QUERY and UPDATE (databases are being initialized).

This value 1s seldom seen.
o opened - available for QUERY and UPDATE.

o failure - failed to open. This can happen for any number of reasons. You can check
this if CAPTURE fails to start or if queries fail to return data. This is normally

caused by database corruption.
Sessions per second rate.

Per second rate at which the service is writing sessions to the database.

Amount of session free space available for aggregation.

Maximum per second rate at which the service is writing sessions to the database.

Number of session bytes in the database.
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Broker Details View

The Broker Details view provides information for the Broker. The following figure depicts the Broker
Details.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Health

liness

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCE2943 @

Broker Details

Host
Service
I Broker
CPU 0.1% Used Memory 27.42 MB
Malware Analysis q"
Running Since 2017-Jul-1010:31:39 Max Process Memory 31.42G8
Build Date 2017-Jul-09 07:19:34 Version Information
Details
Aggregation State stopped Meta Rate 0

Session Rate Meta Rate Max 0

o o

Session Rate Max

RS /\ NETWITNESS PLATFORM

For the related procedure, see Monitor Service Details.

This section displays the current generic statistics for the service.

Description

Aggregation State State of data aggregation.

Meta Rate Metadata objects per second rate.

Session Rate Sessions per second rate.

Meta Rate Max Maximum metadata objects per second rate.

Session Rate Max Maximum sessions per second rate.
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Concentrator Details View

The Concentrator Details view provides information for the Concentrator. The following figure depicts
the Concentrator Details.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN '-“ admin

Health & Wellness

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCE10604 NWAPPLIANCE22655 @

HOST AND SERVICES .
Concentrator Details

Host
Service

I Concentrator

[«:11] 0.5% Used Memory 2.62GB
Running Since 2017-Jul-1010:30:32 Max Process Memory 31.4z2GB
Build Date 2017-Jul-09 07:1%:42 Version Information
Details
Aggregation State started Time Begin 2017-Jun-12 07:54:45
Meta Rate 0 Time End 2017-Jul-11 16:28:44
Meta Rate Max 97222
Session Rate 0
Session Rate Max 1943
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For the related procedure, see Monitor Service Details

The section displays the current generic statistics for the service.

Description

Aggregation State  State of data aggregation.

Time Begin Time (UTC) when the first session was tracked by the index.
Meta Rate Metadata objects per second rate.
Time End Time (UTC) when the last session was tracked by the index.

Meta Rate Max Maximum metadata objects per second rate.
Session Rate Sessions per second rate.

Session Rate Max Maximum sessions per second rate.
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Decoder Details View

The Decoder Details view provides information for the Decoder. The following figure depicts the
Decoder Details.

RSA' RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Health

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCE2943 NWAPPLIANCE23912 @

e Decoder Details
s CcPU 2.6% Used Memory 271.64 MB -
I Decoder Running Since 2017-Jul-12 19:24:52 Max Pracess Memory 31.42GB

Wareholse Connectar Build Date 2017411 07:20:38 Version Information
Details
Capture Status started Meta Bytes 565.67 MB
Capture Kept 483 MB Meta Total 28302428
Capture Dropped 0 Packet Bytes 15.68 GB
Capture Dropped Percent 0% Packet Total 408513335
Capture Rate 0 Session Bytes 400K8
Capture Rate Max 0 Session Total 2712
Time Begin 2016-Sep-20 16:31:56 Pool Packet Write 1]
Time End 2017-Jul-14 12:35:43 Pool Packet Assembler 0
Assembler Packet Pages 37 Pool Packet Capture 49962
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For the related procedure, see Monitor Service Details.

This section displays the current generic statistics for the service.

Description

Capture Status of data capture. Valid values are:
Status « starting - Starting data capture (not capturing data yet).
o started- Capturing data.

« stopping- Stopping data capture (received request to stop data capture, but not have not

stopped capturing data yet).
o stopped - Not capturing data.

« disabled - Not configured as a Decoder service.

Meta Number of meta bytes in the database.
Bytes

Capture Number of packets kept during capture.
Kept
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o o

Meta Number of metadata in the database.

Total

Capture Number of packets reported by the network card as dropped. After the service stops

Dropped  capturing data, rate is reset to zero.

Packet Number of packet bytes in the database.
Bytes

Capture Packets reported by the network card as dropped as a percentage.

Dropped
Percent
Packet Number of packet objects held in the packet database. The total decreases when the
Total database rolls files off due to size constraints. After the service stops capturing data, the
number is not reset.
Capture Megabits per second rate at which the service is capturing data. Rate is a rolling average
Rate sample over a short time period (10 seconds). After the service stops capturing
data, rate is reset to zero.
Session Number of session bytes in the database.
Bytes
Capture Maximum megabits per second rate at which the service is capturing data. Rate is a

Rate Max rolling average sample over a short time period (10 seconds). After the service stops

capturing data, displays the maximum rate during data capture.

Session Number of sessions held in the session database. This value shrinks when the database

Total rolls files off due to size constraints. After the service stops capturing data, the number is
not reset.

Time Time when first packet was captured (time when the first packet was stored in the packet

Begin database). This time increases as packets are rolled out of the packet database.
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e o

Pool Number of packet pages currently in the PCS pipeline that need to be written to the
Packet database.
Write

Time End Time when the last packet was captured (time when packet was written to the database).

The time increases as new packets are captured.

Pool Number of packet pages waiting to be assembled.
Packet

Assembler

Assembler Number of packet pages waiting to be assembled.
Packet

Pages

Pool Number of packet pages available for capture.
Packet
Capture

Event Steam Analysis (ESA) Details View

The Event Stream Analysis Details view provides information for ESA. The following figure depicts the
Event Stream Analysis Details.
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN @:admm O

Service Event Sources Health & Wellness

Alarms Monitoring Policies = System Stats Browser ~ Event Source Monitoring  Settings  [INVEGHRENTES [EE]

HOST AND SERVICES o
ESA Details
Host
Service
I Event Stream Analysis
cpPu 0.2% Used Memory 14 GB
Contexthub Server e 4
Running Since 2017-Jul-11 10:37:31 Max Process Memory 31.42GB
Entity Behavior Analytics
Y vt Build Date 2017-Jul-09 03:33:32 Version Information
Details
Rules Monitor VM

Deployed Rule Memory Utilization Enable & Disable Rules
Event Stream Engine Average Estimated Memory (last hr)

Local ESA (Default)

Local ESA (Default)

Local ESA (Default)

Local ESA (Default)

Local ESA (Defaulz)

RS /\ NETWITNESS® PLATFORM

For the related procedure, see Monitor Service Details.

This section displays the current generic statistics and Rule information for the service. It consists
of Rules, Monitor, and Java Virtual Machine (JVM) tabs that show Event Stream Analysis rules and
additional statistics.

Monitor tab

Displays the following generic statistical information for the Event Stream Analysis service:

o Average number of bytes received per event message field.
o Average number of bytes received per event message.

o Total number of bytes of bytes received.

o Total number of fields received.

o Number of rules deployed on the ESA Service. The Sum of Enabled rules and Disabled rules should
equal to Deployed

o Total number of events matched to all rules on the ESA service.

o Total number of events analyzed by the ESA Service since the last service start.
o Total number of alerts fired based on all the rules on the ESA service.

o Total dropped as late.

o Total fed on time.
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o Total exit early.

o Seconds between feeds.

o Time span in window.

o Total events in window.

o Percent window consumed.

o Total source work units.

o Total bus dropped by payload.

o Total bus dropped events.

o Total bus dropped by fields.

o Total number of alerts sent to the message bus.
o Total number of bus events.

o Total number of Bus work units.

o Total endpoints detected.

o Total lost endpoints.

o Total failed client count.

o Total successful client count.

o Total successful server count.

o Minutes since last success.

o Number of times proxy was requested and granted.
o Total successful requests.

o Number of times proxy was requested and not granted.

o Total unsuccessful requests.

ESA Analytics Details View

The ESA Analytics Details view provides health status information about the selected ESA Analytics
service. ESA Analytics services process the data for automated threat detection. It is important that you
address any checked item that shows a status other than green (healthy), so that data processing is not
interrupted and critical events are not missed.

The following figure shows the ESA Analytics Details view.
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L@J admin &

HEALTH & WELLNESS SECURITY

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCE10604 @

HOST AND SERVICES . A
Event Stream Analytics Server Details

Host
Service
Event Stream Analysis
CcPU 0.1% Used Memo 653.36 MB
Contexthub Server v
Running Since 2017-Jul-13 08:04:02 Max Process Memery 31.42GB
Entity Behavior Analytics
I Y ‘ Y Build Date 2017-Jul-05 18:39:19 Version Information
Health Stats VM
Configuration Update Status Healthy Process Modules Healthy
Process JVM Memory Healchy Security PKI Certificate Healthy
Data Connection Healthy

RS /\ NETWITNESS™ PLATFORM

For the related procedure, see Monitor Service Details.

ESA Analytics Details
This section displays the current generic statistics for the selected ESA Analytics service.
Health Status

The Health Status section shows the health of the following items for the selected ESA Analytics
service:

e Mongo

JVM (Java Virtual Machine)

Disk Space

o Suspicious Domains Module

o User Behavior Analytics Module

The following table describes the meaning of each health status.

Description
Green Healthy
Yellow Unhealthy
Red Critical and it needs immediate attention.

127 References



System Maintenance Guide

Description

-- Inapplicable

Host Details View

The Host Details view provides information about a host. The following figure depicts the Host Details.

RSA RESPOND INVESTIGATE MONITOR CONFIG

Healt ness

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCES @

HOST AND SERVICES

Host Details
I Host
System Info
Broker
- P
. Host NWAPPLIANCES Memory Utilization 69.18%
R cPU 3.01% Used Memory 21.74GB
el S0ENEr Running Since 2017-ul-10 09:44:02 Tetal Memory 31aaGe
Security Server Current Time 2017-Jul-11 16:43:42 Cached Memory 203GB
I Uptime 1 day 6 hours 59 minutes 40 seconds Swap Utlization o
Used Swap 0 bytes
System Info 5
] Linux 3.10.0-514.26.2.¢17.x86_64 x86_64
Config Server s R BT Total Swap 400GB
Investigate Server
Respond Server Physical Drive || Logical Drive | File System Adapter Message Bus
State Enclosure slot Failure Count | Raw Size Inquiry Data

RS /\ NETWITNESS' PLATFORM

The options panel on the left displays the host and the services installed on the host. You can click on
Host any service to view the statistics and other pertinent information for that host or service.

The Details panel displays information that is specific to the host and provides additional information
regarding the hardware of the host.

For the related procedure, see .Monitor Service Details

This section displays the current performance, capacity, and historical statistics for the host.

Parameter Description

Host Hostname.

CPU Current CPU usage of the host.
Running Since Time when the host was started.
Current Time Current time on the host
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Uptime

Time for which the host has been active.

System Info OS version installed on the host.

Memory Utilization Percentage of memory utilized by the host.

Used Memory Memory used in GB.

Total Memory Capacity of the memory installed on the system.

Cached Memory Memory that is cached to disk in GB.

Swap Utilization Percentage of system swap in use.
Used Swap Swap used in GB.
Total Swap Capacity of the swap installed on the system.

The lower section displays the current generic statistics for the host in the tabs described in the following
table.

Physical
Drive

Logical
Drive

File
System

Adapter

Type of physical drive, its usage and additional information of the physical drive on the
host.
Logical drive on the host.

File system information, the size, current usage and available capacity on the host.

Adapter used on the host.
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Message Ppublish In Rate - rate at which incoming messages are published to the message bus
Bus

queue.
Total Messages Queued - number of messages in the message queue.

Memory Used - amount of memory used by the message bus (in bytes).

Disk Free - free disk space available for the message bus (in bytes).

Memory Limit - system memory limit. If the memory usage exceeds this value, this trips
the Memory Alarm and Security Analytics stops accepting messages.

Disk Free Limit - limit of free disk space available for the message bus. If the available
disk space falls below this value, this trips the Disk Free Alarm and Security Analytics
stops accepting messages.

Memory Limit Available - Amount of memory available to this message broker (in bytes)
before the Memory Used Alarm is tripped.

Disk Limit Available - Amount of free disk space available to this message broker (in
bytes) before the Disk Free Limit alarm is tripped.

Disk Free Alarm - True or False. True indicates that the available disk space is below
the value set in Disk Free Limit and Security Analytics has stopped accepting messages.
Memory Alarm - True or False. True indicates that the available memory is below the

value set in Memory Limit and Security Analytics has stopped accepting messages.

Log Collector Details View

The Log Collector Details view provides information for the Log Collector. The following figure depicts
the Log Collector Details.
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RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Heal

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings RPN e I NWAPPLIANCE11639 @

HOST AND SERVICES

Log Collector Details

Host

Service
| Log cottector

CcPU 1% Used Memao: 54.09 MB

Log Decoder o "
Running Since 2017-Jul-12 10:23:15 Max Process Memory 31.42GB

Wareh nnector .

PRUEIEE Build Date 2017-Jul-08 01:01:37 Version Information

Collection | Event Processing

Transport Protocol Status EPS Total Events Errors Warnings
checkpoint stopped 0 0 0 0 E

netflow stopped 0 ] 0 0

file stopped 0 ] 0 0

sdee stopped 0 0 0 0

odbe stopped 0 0 0 0
vmware stopped 0 0 0 0
syslog stopped 0 o 0 0
windows stopped 0 1] 0 0
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For the related procedure, see Monitor Service Details.

The lower section consists of the Collection and Event Processing tabs that display generic statistics
for the service.

Collection Tab

Displays the event collection statistics for each Log Collection protocol you have implemented in
NetWitness Platform (see "Log Collection Getting Started Guide" in the Log Collection Guides).

Event Processing Tab

Displays statistics for the NetWitness Platform internal event processing protocol (that is, the Log
Decoder) for Log Collection.

Parameter | Description

Transport NetWitness Platform protocol use for Log Collections (that is, the Log Decoder).

Protocol
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Status Status of the Log Decoder. Valid values are:

 starting - Starting data capture (not capturing data yet).
o started - Capturing data.

« stopping- Stopping data capture (received request to stop data capture, but not have
not stopped capturing data yet).

« stopped - Not capturing data.

« disabled - Not configured as a Decoder service.

EPS Rate (events per second) at which this the Log Decoder is processing events from the

Log Collector.
Total Events Total events processed by the Log Decoder.
Errors Number of errors encountered.
Warnings Number of warnings encountered.

Byte Rate Current throughput in bytes per second.

Log Decoder Details View

The Log Decoder Details view provides information for the Log Decoder. The following figure depicts
the Log Decoder Details.
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RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Health & Wel

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCE9 NWAPPLIANCE11639 @

HOST AND SERVICES
Log Decoder Details
Host
Service
Log Collector
CcPU 23% Used Memory 1.73GB
I Log Decoder
Running Since 2017-Jul-12 10:23:15 Max Process Memory 31.42GB
Warehouse Connector -
Build Date 2017-Jul-09 07:20:33 Version Information
Details
Capture Status started Packet Rate Max 1
Events Per Second 0 Pool Packet Capture 50000
Meta Rate o Pool Packet Assembler 0
Meta Rate Max 65 Assembler Packet Pages 0
Capture Dropped 0 Pool Packet Write 0
Capture Dropped Percent 0% Time Begin 2017Jul-10 11:58:52
Time End 2017-Jul-12 11:36:58
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For the related procedure, see Monitor Service Details.

This section displays the current generic statistics for the service.

Description

Capture Status of data capture. Valid values are:

Status starting - Starting data capture (not capturing data yet).
o started - Capturing data.
« stopping - Stopping data capture (received request to stop data capture, but not have
not stopped capturing data yet).
« stopped - Not capturing data.
o disabled - Not configured as a Log Decoder service.
Packet Maximum per second rate at which the service is writing packets to the database. Rate is

Rate Max a rolling average sample over a short time period (10 seconds). After the service stops

capturing data, displays the maximum rate during data capture.

Events Per Rate (events per second) at which the Log Decoder is processing events from the Log

Second Collector.
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e o

Pool Number of packet pages available for capture.

Packet
Capture

Meta Rate Per second rate at which the service is writing metadata objects to the database. Rate is a
rolling average sample over a short time period (10 seconds). After the service stops

capturing data, rate is reset to zero.

Pool Number of packet pages waiting to be assembled.
Packet

Assembler

Meta Rate Maximum per second rate at which the service is writing metadata objects to the
Max database. Rate is a rolling average sample over a short time period (10 seconds). After

the service stops capturing data, displays the maximum rate reached during data capture.

Assembler Number of packet pages waiting to be assembled.
Packet

Pages

Capture Number of packets reported by the network card as dropped. After the service stops

Dropped  capturing data, rate is reset to zero.

Pool Number of packet pages in the PCS pipeline that need to be written to the database.
Packet
Write

Capture Packets reported by the network card as dropped as a percentage.

Dropped

Percent

Time Time when first packet was captured (time when the first packet was stored in the packet
Begin database). This time increases as packets are rolled out of the packet database.

Time End Time when the last packet was captured (time when packet was written to the database).

The time increases as new packets are captured.
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Malware Details View

The Malware Details view provides information for Malware Analysis. The following figure depicts the
Malware Details.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN () admin &

Event Sources Health & Wellness

Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCE10604 <  NWAPPLIANCE22655 NWAPPLIANCE2943 @ | >

HOST AND SERVICES A harar -
Malware Details

Host
Service

Broker

. cpPu Used Memory
I Malware Analysis
Running Since Max Process Memory
Build Date Version Information
Events M

Number Of Events For Past 24 Hours Average Pracessing Time
Number Of Files For Past 24 Hours Events In Queue
Number Of Events For Past 7 Days Events Processed
Number Of Files For Past 7 Days Events Per Second Throughput
Number Of Events For Past Month Session Time Of Last Event
Number Of Files For Past Month
Number Of Events For Past 3 Months
Number Of Files For Past 2 Months
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For the related procedure, see Monitor Service Details.

Displays the following event-related statistical information for the Malware Analysis service.

o Number of events for the past 24 hours
o Average processing time

o Number of files for the past 24 hours

« Events in queue

o Number of events for the past 7 days

o Events processed

o Number of events for the past 7 days

o Events per second throughput

o Number of events for the past month

o Session time of the last event

o Number of files for the past month
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o Number of events for the past 3 months

o Number of files for the past 3 months

Warehouse Connector Details View

The Warehouse Connector Details tab provides information for the Warehouse Connector, such as the
date it was built, CPU, and version information. The following figure depicts the Warehouse Connector

Details.

RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Health & Wellness

Alarms  Monitoring  Policies  System Stats Browser  Event Source Monitoring  Settings  ENZUIIEEUTo IR EEEE]

HOST AND SERVICES Al S ==
Warehouse Connector Details

Host
Service

Log Collector
CPU Used Memaory

Log Decoder

Running Since Max Process Memory 31.42GB
Warehouse Connector . .
I Build Date Version Information
Details
Streams Complete Streams Running
Streams Incomplete Streams Stopped

Streams Total

RS /\ NETWITNESS' PLATFORM

For the related procedure, see Monitor Service Details.
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Policies View

The required permission to access this view is Manage services.

What do you want to do?

Administrator View the policies NetWitness Server and Services Manage Policies

Administrator Add, Edit, Duplicate, and Delete Policies Manage Policies

Quick Look

The figure depicts the Policies view.

RSA RESPOND IN IGATE MONITOR

Heal lIne

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings

Policies
+ - zZ® ¥

dmin Server: Admin Server Monitoring Policy |'

ules and suppression schedules of Out-of-the-box policies cannat be directly modified. Duplicate the policy if you Wish to so madify them

¥ Enable Last Modified: 2017-02-20 12:00:00 AM
43 Admin Server O .
@ Admin Server Monitoring Policy Services
¥ [ Archiver o Choose the hosts, services, and groups that your health policy applies to
» [ Broker ) + -
» [JConcentrater ) O Name ~ Group Type
» [ Config Server @ 0 Al 10 Group
» [ Contexshub Server )
Rules
» [Deceder L] Define the conditions under which you want to trigger an alarm for the NetWitness Platform health problems (definition includes severity, statistic the alarm applies to, ,
hresh hich th he alarm rul )
» [ Ensicy Behsvior Anslysics o threshold, and threshold at which the alarm clears). After you define the alarm rule, enable or disable the alarm
» [JEvent Stresm Analysis o
» CHost o L] Enable Name ~ Severity Category Statistic Threshold
[0 ® AdminServer.. Critica Processinfo Overall Processing Status Indicator  Alarm = ERROR for 2 MINUTES
» [lnvestigate Server )
[ ® AdminServer.. High Processinfo Overall Processing Status Indicator  Alarm = PARTIALLY_WORKING for 2 MINUTES
[, ]

» Loz Callector

B Policies Panel

A Policy Detail Panel

1. Goto ADMIN > Health & Wellness.

2. Click the Policies tab.

Policies Panel

In the Policies panel, you can add or delete policies for hosts and services in this panel.

137 References



System Maintenance Guide

e o

L

Displays available service types to create a new policy . Select one so that you can define

a policy or policies for it.

Deletes the selected policy from the Policies panel. You can only delete one policy at a

time.
Allows you to change the name of the policy.

Creates a copy of the selected policy. For example, if you select First Policy and click E,

NetWitness Platform creates a copy of this policy and names it First Policy (1).

Expands the list of policies under the services and hosts in the Policies panel.

Contracts the list of policies under the services and hosts in the Policies panel.

List of:
o Services and hosts for which you have defined policies.

o RSA standard policies that you can apply to hosts and services.

Policy Detail Panel

The Policy Detail panel displays the policy selected from the Policies panel.

e Jowamin =

Save Saves any changes you made in this panel.
Policy Type Displays the type of policy you selected.
Modified Displays the last date this policy was modified.
Date
[] Enable  Select and deselect this checkbox to enable and disable the policy.
Services
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o Jowamin

+ - Displays menu in which you select:

o Groups to display the Groups dialog from which you select service groups to this

policy.

o Service/Host to display the Services/Hosts dialog from which you select services to
add to this policy. If policy type is Host, the menu will have Host not Service. You

can select services based on policy type.

- Deletes the selected service or group from this policy.

Rules

+ Displays the Add Rule dialog in which you define a rule for this policy.
- Deletes the selected rule from this policy.

4 Displays the Edit Rule dialog for the selected rule.

Policy Suppression

+ Adds a policy suppression timeframe row.

- Deletes the selected policy suppression timeframe row.

Time Zone Selects the time zone for the Policy from the drop-down list. This time zone applies to

both Policy Suppression and Rule Suppression.

[ Selects the checkbox to select a policy suppression timeframe row.

Days Days of the week that you want to suppress the policy according to the time range
specified. Click on the day of the week that you want to suppress the policy. You can

select any combination of days including all days.

Time Time range during which the policy is suppressed for the days selected.

Range

Notifications
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o Jowamin

+ Adds an EMAIL notification row.

- Deletes the selected policy suppression timeframe row.

Notification Opens the Notification Servers view in which you can define the Email notification

Settings settings.
[ Selecting the checkbox selects a policy suppression time frame row.
Output The type of notification defined on the Global Notifications page. Can be email, SNMP,

Syslog, or Script.

Recipient ~ The name of the person receiving the notification.

Notification Select the EMAIL notification server. See "Configure Notification Servers" in the

Server System Configuration Guide for the source of the values in this drop-down list.

Template Select the Template for this EMAIL notification. RSA provides the Health & Wellness
Default SMTP Template and the alarms template. See" Configure Notification
Templates"in the System Configuration Guide for the source of the other values in this
drop-down list.

Note: Refer to Include the Default Email Subject Line if you want to include the
default Email subject line from the Health & Wellness template in your Health &
Wellness Email notifications for specified recipients.

Groups dialog

e o

Groups panel

Name Displays the service groups you have defined. You can select:

o All to display all your services in the Services panel.

o A group to display the services in comprise that group in the Services

panel.

Services panel
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o o

Name Displays the name of the service.
Host Displays the host on which the service is running.
Type Displays the type of service.

Rules Dialog

Foawrs Jowerpten

[] Enable

Select and deselect this checkbox to enable and disable the rule for this policy.

Name Enter the name of the rule.

Description Enter the description of the rule. RSA suggests that you include the following information
in this field.

» Informational description - purpose of the rule and what problem it monitors.

. Remediation - steps to take to resolve the condition that triggers the alarm for this
rule.

Severity Select the severity of the rule. Valid values are:

o Critical
o High
° Medlum

o Low
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e Jowmn

Statistic Select the statistics you want to check with this rule. You can select:

« Statistical category from the left drop-down list.

« Statistic from the right drop-down list.

Note: For Public Key Infrastructure (PKI) policy, select PKI in the category and
statistics as any one of the following:

- NetWitness Server PKI Certificate Expiration - Displays the time left before the
certificate expires.

- NetWitness Server PKI CRL Expiration - Displays the time left before the
Certificate Revocation List (CRL) expires.

- NetWitness Server PKI CRL Status - Displays the current status of the CRL.

Please refer to the System Stats Browser View for examples of the statistics you may
want to check with a rule.

Alarm Define the threshold of the rule that will trigger the policy alarm:
Threshold ~ « Amount

Note: For CRL expiry the supported format is ddddhhmm, for example:
- 10000 represent 1 day

- 2359 represent 23 hours and 59 minutes

- 10023 represent 1 day and 23 minutes

- 3650100 represent 365 days and 1 hour

o Time in minutes

Recovery ~ Defines when to clear the threshold of the rule:

o Operator:

o For NetWitness Platform 10.5 (5, !=, <, <=, >, or >=)

o For NetWitness Platform 10.5.0.1 and later (See Threshold Operators below)
o Amount

¢ Time in minutes

Rule Suppression

=+

Selecting this option allows you to add a rule suppression timeframe row.

Selecting this option allows you to delete the selected rule suppression time frame row.

References 142



System Maintenance Guide

e Jowmn

[ Selecting the checkbox allows you to select a rule suppression time frame row.

Time Zone: Displays the Policy time zone. You select the time zone for a policy in the Policy

time-zone  Suppression panel.

Days Days of the week that you want to suppress the rule according to the time range
specified. Click on the day of the week that you want to suppress the rule. You can

select any combination of days including all days.

Time Time range during which the rule is suppressed for the days selected.

Range

Threshold Operators

The Alarm Threshold and Recovery Threshold fields in the Rules dialog prompt you for either
numeric or string operators based on the statistic criteria you specify.

Numeric operators drop-down menu: String operators drop-down menu:
o v = v
I= =
< Contains
== IContains
= Regex Match
== IRegex Match
InRange
lInRange

RSA Health & Wellness Email Templates

Note: Please refer to Include the Default Email Subject Line if you want to include the default Email
subject line from the Health & Wellness template in your Health & Wellness Email notifications for
specified recipients.
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Health & Wellness Default SMTP Template

RSA NetWitness Suite

Health Alarm Notification

File Collection Service is off on HOST1000

State
Active

Severity
High

Host
HOST1000

Service
Log Collector

Alarmid
103-2248-0001

Palicy
Check Point

Rule
File Collection Service is off

Statistic
Collection State

Value

stopped

Time

April 13, 2018 10:48:13 PM UTC
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Alarms Template

RSA NetWitness Suite

Health Alarm Notification

File Collection Service is off onHOST1000

State
Cleared

Severity
High

Host
HOST1000

Service
Log Collector

Alarmid
103-2248-0001

Policy
BootCamp Notification

Rule
Check Point Collection is off

Statistic
Collection State

Value
Policy-Disabled

Time
April 14, 2018 2:31:21 AM UTC

NetWitness Platform Out-of-the-Box Policies

The following table lists the NetWitness Platform Out-of-the-Box Policies with the rules defined for
each policy.

You can perform the following tasks on any of these policies:

o Change service/group assignments.

o Disable/enable them.

You cannot perform the following tasks on any of these policies:

o Delete them.

« Edit Policy names.
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Note: Additional information about the Out-of-the-Box Policies can be found in the User Interface

under
Health & Wellness — Policies.

Policy Name Alarm Triggered

Communication Failure Host is down, Network is down, Message

Between Master Security Broker is Down, or Invalid or missing security
Analytics Host and a Remote  certificates for 10 minutes or more.

Host
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Policy Name Alarm Triggered

NetWitness

Server Monitoring

Critical Usage on Rabbitmq

Message Broker Filesystem

Filesystem is Full

High Filesystem Usage

High System Swap Utilization

High Usage on
Rabbitmq Message Broker

Filesystem
Host Unreachable

LogCollector Event Processor

For var/1ib/rabbitmg, Mounted Filesystem

Disk Usage goes over 75%.

Overall Mounted Filesystem Disk Usage
reaches 100%.

Overall Mounted Filesystem Disk Usage goes

over 95%.

Swap Utilization goes under 5 % for 5 minutes

or more.

Mounted Filesystem Disk Usage for

var/lib/rabbitmg goes over 60%.

Host down.

Issue with Log Collection Message Broker

Policy Exchange Bindings Status Queues for 10 minutes or more.
LogCollector Event Processor  Issue with Log Collection Message Broker
Queue with No Bindings Queues for 10 minutes or more.
LogCollector Event Processor  Issue with Log Collection Message Broker
Queue with No Consumers Queues for 10 minutes or more.
Power Supply Failure Host not receiving power.
RAID Logical Drive Degraded For Raid Logical Drive, Drive State equals
Degraded or Partially Degraded.
RAID Logical Drive Failed For Raid Logical Drive, Logical Drive State
equals Offline, Failed, or Unknown.
RAID Logical Drive For Raid Logical Drive, Logical Drive State
Rebuilding equals Rebuild.
147 References



System Maintenance Guide

Policy Name Alarm Triggered

NetWitness
Platform Archiver

Monitoring Policy

RAID Physical Drive Failed

RAID Physical Drive Failure
Predicted

RAID Physical Drive
Rebuilding

RAID Physical Drive
Unconfigured

SD Card Failure
Archiver Aggregation Stopped

Archiver Database(s) Not
Open

Archiver Not Consuming From

Service
Archiver Service in Bad State

Archiver Service Stopped

For Raid Physical Drive, Physical Drive
State does not equal Online, Online Spun

Up, or Hotspare.

For Raid Physical Drive, Physical Drive

Predictive Failure Count is greater than 1.

For Raid Physical Drive, Physical
Drive State equals Rebuild.

For Raid Physical Drive, Physical

Drive State contains Unconfigured(good).
SD Card Status does not equal ok.
Archiver Status does not equal started.

Database Status does not equal opened.

Devices Status does not equal consuming.

Service State does not equal started or ready.

Server Status does not equal started.
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Policy Name Alarm Triggered

NetWitness Broker >5 Pending Queries Queries Pending greater than or equal to 5 for
Platform Broker 10 minutes or more.
Monitoring Policy

Broker Aggregation Stopped Broker Status does not equal started.

Broker Not Consuming From Devices Status does not equal consuming.

Service

Broker Service in Bad State Service State does not equal started or ready.
Broker Service Stopped Server Status does not equal started.

Broker Session Rate Zero Session Rate (current) equals 0 for 2 minutes

Oor more.
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Policy Name Alarm Triggered

NetWitness Concentrator >5 Pending Queries Pending greater than or equal to 5 for
Platform Queries 10 minutes or more.
Concentrator ) ) ) o
Concentrator Aggregation Devices Sessions Behind is greater than or
Monitoring Policy ) ) .
Behind >100K Sessions equal to 100000 for 1 minute or more.
Concentrator Aggregation Devices Sessions Behind is greater than or
Behind >1M Sessions equal to 1000000 for 1 minute or more.
Concentrator Aggregation Devices Sessions Behind is greater than or
Behind >50M Sessions equal to 50000000 for 1 minute or more.
Concentrator Aggregation Broker Status does not equal started.
Stopped

Concentrator Database(s) Not ~ Database Status does not equal opened.

Open

Concentrator Meta Rate Zero ~ Concentrator Meta Rate (current) equals 0 for

2 minutes or more.

Concentrator Not Consuming Devices Status does not equal consuming.

From Service

Concentrator Service in Bad Service State does not equal started or ready.

State

Concentrator Service Stopped  Server Status does not equal started.
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Policy Name Alarm Triggered

NetWitness
Platform Decoder

Monitoring Policy

NetWitness
Platform Event
Steam Analysis

Monitoring Policy

Decoder Capture Not Started

Decoder Capture Rate Zero

Decoder Database Not Open

Decoder Dropping >1% of

Packets

Decoder Dropping >10% of

Packets

Decoder Dropping >5% of

Packets

Decoder Packet Capture Pool
Depleted

Decoder Service in Bad State
Decoder Service Stopped

ESA Overall Memory
Utilization > 85%

ESA Overall Memory
Utilization > 95%

ESA Service Stopped

ESA Trial Rules Disabled

Capture Status does not equal started.

Capture Rate (current) equals 0 for 2 minutes

or more.
Database Status does not equal opened.

Capture Packets Percent Dropped (current) is

greater than or equal to 1%.

Capture Packets Percent Dropped (current) is

greater than or equal to 10%.

Capture Packets Percent Dropped (current) is

greater than or equal to 5%.

Packet Capture Queue equals 0 for 2 minutes

or more.
Service State does not equal started or ready.
Server Status does not equal started.

Total ESA Memory Usage % is greater than or
equal to 85 %.

Total ESA Memory Usage % is greater than or
equal to 95 %.

Server Status does not equal started.

Trial Rules Status does not equal enabled.
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Policy Name Alarm Triggered

NetWitness IPDB Extractor Service in Bad Service State does not equal started or ready.

Platform IPDB State

Extractor

Monitoring IPDB Extractor Service Server Status does not equal started.
Policy Stopped

NetWitness Incident Management Service  Server Status does not equal started.

Platform Incident Stopped

Management
Monitoring
Policy
NetWitness Log Collector Service Stopped  Server Status does not equal started.
Platform Log ) .
Log Decoder Event Queue > Number of events currently in the queue is
Collector )
50% Full using 50% or more of the queue.
Monitoring
Policy Log Decoder Event Queue > Number of events currently in the queue is
80% Full using 80% or more of the queue.

Log Collector Service in Bad  Service State does not equal started or ready.

State
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Policy Name Alarm Triggered

NetWitness
Platform Log
Decoder
Monitoring

Policy

NetWitness
Platform Malware
Analysis
Monitoring

Policy

Decoder Dropping>10% of
Packets

Log Capture Not Started

Log Decoder Capture Rate

Zero

Log Decoder Database Not
Open

Log Decoder Dropping >1% of
Logs

Log Decoder Dropping >5% of
Logs

Log Decoder Packet Capture
Pool Depleted

Log Decoder Service Stopped

Log Decoder Service in Bad

State

Malware Analysis Service

Stopped

Capture Packets Percent Dropped (current) is
greater than or equal to 10%

Capture Status does not equal started.

Capture Rate (current) equals 0 for 2 minutes

or more.

Database Status does not equal opened.

Capture Packets Percent Dropped (current) is

greater than or equal to 1%.

Capture Packets Percent Dropped (current) is

greater than or equal to 5%.

Packet Capture Queue equals 0 for 2 minutes

or more.
Server Status does not equal started.

Service State does not equal started or ready.

Server Status does not equal started.
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Policy Name Alarm Triggered

NetWitness Reporting Engine Alerts Alerts Utilization is greater than or equal to 10
Platform Critical Utilization for 5 minutes or more.
Reporting Engine ) ) ) . ) )
Reporting Engine Available Available disk space is less than 10%.
Monitoring .
Disk <10%
Policy
Reporting Engine Available Available disk space is less than or equal
Disk <5% to 5%.
Reporting Engine Charts Charts Utilization is greater than or equal to 10
Critical Utilization for 5 minutes or more.
Reporting Engine Rules Rules Utilization is greater than or equal to 10
Critical Utilization for 5 minutes or more.
Reporting Engine Schedule Schedule Task Pool Utilization is greater than
Task Pool Critical Utilization  or equal to 10 for 15 minutes or more.
Reporting Engine Service Server Status does not equal started.
Stopped
Reporting Engine Shared Task  Shared Task Pool Utilization is greater than or
Critical Utilization equal to 10 for 5 minutes or more.
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Policy Name Alarm Triggered

NetWitness
Platform
Warehouse
Connector
Monitoring

Policy

NetWitness
Platform
Workbench
Monitoring Policy

Warehouse Connector Service

in Bad State

Warehouse Connector Service

Stopped

Warehouse Connector Stream

Behind

Warehouse Connector Stream

Disk Utilization > 75%

Warehouse Connector

Stream in Bad State

Warehouse Connector Stream
Permanently Rejected Files >

300

Warehouse Connector Stream
Permanently Rejected Folder >

75% Full

Workbench Service in Bad

State

Workbench Service Stopped

Service State does not equal started or ready.

Server Status does not equal started.

Stream Behind is greater than or equal to

2000000.

Stream Disk Usage (Pending Destination

Load) is greater than or equal to 75.

Stream Status does not equal consuming or

online for 10 minutes r more.
Number of files in the permanently rejected

files is greater than or equal to 300.

Rejected folder usage is greater than or equal

to 75%.

Service State does not equal started or ready.

Server Status does not equal started.
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System Stats Browser View

NetWitness Platform provides a way to monitor the status and operations of hosts and services. The
System Stats Browser tab displays key statistics, service system information, and host system
information for a host or service.

You can customize the stats view depending on the parameter you select to filter the data.
To access the System Stats Browser view:
1. Goto ADMIN > Health & Wellness.

The Health & Wellness view is displayed with the Alarms tab open.

2. Click the System Stats Browser tab.

What do you want to do?

Administrator ~ View the System Stat Historical Graph Historical Graph for System Stats

Related Topics

Monitor Service Statistics

Filter System Statistics

Quick Look

The System Stats Browser view is displayed.

Event Source Monitoring Settings

2
Host Component Category Statistic Order By .
Any w | Any w Ay w Clear
Regex [TReges @Ascending (Dewending
Host Component Category Statistic SuBitem valug Last Update Historical Graph
ocalhost localdomain Host FileSystem Error Status i 2017-05-17 05:32:38 PM d
A

ocalhost localdomain Host FileSystem Mounted Filesystemn Disk Usage /dev 2017-05-17 05:32:38 PM 4
ocalhost localdomain Host FileSystem Mounted Filesystem Disk Usage Isysifsicgroup 2017-05-17 05:32:38 PM al
ocalhost localdomain Hiost FileSy=tem Mounted Filesystemn Disk Usage frun 2:38 PM 4
ocalhost localdomain Hest FileSystem Meounted Filesystem Disk Usag 3Z3IEPM 4
ocalhostlocaldomain Host FileSystem Mounted Filesystemn Disk Usage /devfshm 238 PM o

it Jidama § Sys " 1D 1 ham 05:32:38 PM =]
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Displays System Stats Browser View
Toolbar used to filter and customize the System Stats Browser View

Note: Historical graphs are enabled, and can be displayed, for statistics with numeric values.
However, historical graphs are disabled for statistics with string values, for example, Health checks
(Healthy), and are displayed as gray in the UL

Filters

This table lists the various parameters you can use to filter and customize the System Stats view.

Host

Component

Category

Statistic

Order By

Commands

Select a host from the drop-down menu to display the stats of the selected host.

Select Any to list all the available hosts.

Select a component from the drop-down menu to display the stats for the selected

component.

Select Any to list out all the components on a selected host.

Type the category to display the stats for the required category.
Select Regex to enable Regex filter. It performs a regular expression search against
text and lists out the specified category. If Regex is not selected it

supports globbing pattern matching.

Type the statistic to display the required statistic on all the hosts or components.
Select Regex to enable Regex filter. This performs a regular expression search against
text and lists out the specified category. If Regex is not selected it

supports globbing pattern matching.

Select the order in which the list needs to be filtered.

Select Ascending to filter the list it in an ascending order.

T

Apply

Clear

Click to apply the filters chosen and display the list accordingly.

Click to clear the chosen filters.
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System Stats View Display

Displays statistics, service system information, and host system information for a host or service.

Access Stats Details

Select one of the stats and click Stats Details on the right hand side of the panel.

The Stats details panel opens with details of the selected stats.

Stat Details
Host
Hostname
Component 1D

Component

Physical Drive

N

stat_collector_wversion

Current Cache Policy

031bcf81-073f-4a0d-ae54-adbB8245399c
S5ESAPrimary

appliance

Host

Logical Drive State

0.1

appliance_diskraid_logicaldrive
01

string

state

Disk Raid Logical Drive state and other details for drive in
Adapter 0 Virtual Drive 1

DiskRaid
2018-02-19 07:15:44 AM
Optimal
Optimal

031bcfe1-073f-4a0d-ae54-
adb&249399fc/appliance_diskraid_logicaldrive-
0.1/string-state

0.32.3,0.32.2,0.32.4,0.32.1, 0.32.0
11.1.0.0
WriteBack, ReadAhead, Cached, Write Cache OK if Bad BBU
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System View - System Info Panel
This topic describes the System Information panel, which displays information about the system version
and license status.
The required role to access this view is Manage System Settings.
To access this view, do one of the following:
o Goto ADMIN > System.
The System Information panel is displayed by default.

o When you receive a notification that a new version of NetWitness Platform is available in the

Notifications tray, click View.

RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

em  Security

Info .
I Version Information

Updates
Current Version

Licensing current Build 180214015530

Email License Server ID ECF4BBEST3A0
Global Notifications
Legacy Notifications
System Logging
Global Auditing

Jobs

Live Services

URL Integration
Context Menu Actions
Investigation

ESA Analytics

Cloud Gateway
Whois

HTTP Proxy Settings

NTP Settings

RS /\ NETWITNESS' PLATFORM 11.1.0.0

The Version Information section displays version information about the version of NetWitness Platform
that is currently installed. The following table describes the features of the Version Information section.

159 References



System Maintenance Guide

o

Displays the version of Security Analytics that is currently running. The format of the
version is major-relase.minor-release.stability-id. build-number. Possible values for the

stability-id are:

Current ©* |- Development
Version o 2- Alpha
e 3-Beta
e 4-RC
e 5-Gold
Current Identifies the current build revision for use in troubleshooting situations.
Build
Each client host is shipped with the Local Licensing Server (LLS) installed to manage host
License licenses. This field indicates whether the LLS is installed for this instance of Security
Server  Analytics.
ID o When the LLS is installed, the Licensing Server ID is displayed.
o Unknown indicates that the LLS is not installed.
Indicates whether or not the license is enabled. If the license is:
License ° Enabled, Enabled is displayed in this field and there is a Disable button to the right so
ST you can disable it.
« Disabled, Disabled is displayed in this field and there is an Enable button to the right so
you can enable it.
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System Updates Panel - Settings Tab

System Updates Settings tab describes the interface you use to set up a connection to Live Update
Repository. These settings ensure that the NetWitness Platform can reach the Live Update
Repository and synchronize it with your Local Update Repository.

The required permission to access this view is Apply System Updates.

To access this view:

1. Goto ADMIN > System.

2. Select Updates.

What do you want to do?

Administrator Automatically download Enable automatic synchronization with the RSA update

updates repository.

Related Topics

Managing NetWitness Platform Updates

Quick Look

The System Updates Settings panel is displayed.

Info

System Updates Settings

I Updates t H Configure Live account (required) I E

Configure proxy settings

Licensing
# Automatically download information about new updates every day
Email
Apply
Global Notifications
Legacy Notifications

System Logging

VR B W L

Displays System Update Setting Tab
Configure Account and Setting for Automatic Updates
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Features

This table describes the features in the System Updates Settings panel.

s oeseelon

Configure Live account ~ Displays the ADMIN > System > Live Services panel in which you can
configure your Live Account credentials if they are not configured.

Configure proxy settings ~ Displays the ADMIN > System > HTTP Proxy Settings panel in which
you can configure an HTTP proxy if it is not configured.

Automatically download  Select to enable automatic synchronization with the RSA update

information about new repository. If there are new updates available, information will
updates every day automatically be displayed in the ADMIN > HOSTS panel.
Apply Applies the settings in this tab.
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System Logging - Settings View

The RSA NetWitness PlatformSettings view in the System Logging panel configures the size of the log
files, the number of backup log files maintained, as well as the default logging levels for the packages
within NetWitness Platform. The Configure Log File Settings topic in the System Configuration Guide
provides detailed procedures.

To access the Settings tab:

1. Goto ADMIN > System.

2. In the options panel, select System Logging.
The System Logging panel opens to the Realtime tab by default.

3. Click the Settings tab.

What do you want to do?

Administrator Configure the size of the Log files Setup the Log Settings Toolbar

Related Topics

System Logging - Historical Tab

System Logging - Realtime Tab
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Quick Look

(&) admin

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

System

(oo System Logging
Updates

P Realtime | Historical Settings "—E
Licensing

Email tti

Log Settings 4,_5

Global Notifications Max Log Size 4184304

Legacy Notifications Max # Backup Files 9

| system Lo%ng‘_n ¥ Show Error Stack Trace
Global Auditing Apply

Jobs

Live Services Package Configuration o
URL Integration B[ Jcom -

Context Menu Actions B Connection

B DateAccess

Investigation

B eu
ESA
K Fop
ESA Analytics
A B[ freemarker
Whois. B[ javax
HTTP Proxy Settings B[ e
NTP Settings B[Jorg
B Securiy . =

RS /\ NETWITNESS  PLATFORM

Displays System Logging Panel

Displays Settings Tab

The section allows the user to configure Log Settings
The section allows the user to configure Package

Features
The Settings tab has two sections: Log Settings and Package Configuration.

Log Settings

The Log Settings section configures the size of the NetWitness Platform log files and the number of
backup logs that NetWitness Platform maintains.

Description

Max Log Configures the maximum size in bytes of each log file. The minimum value for this setting

Size 1s 4096.

165 References



System Maintenance Guide

e o

Max #
Backup
Files

Show
Error
Stack
Trace

Apply

Specifies how many backup log files are maintained. The minimum value for this setting is
0. When the maximum number of log files is attained, and a new backup file is made, the

oldest backup is discarded.

Select checkbox to display ERROR, STACK, and TRACE log messages.

Puts the settings into effect immediately for all future logs.

Package Configuration

The Package Configuration section shows the NetWitness Platform packages in a tree structure.

o o = SR

Package

tree

Package
field

Log Level

Reset

recursively
Apply

Reset

The tree contains all the packages used within NetWitness Platform. You can drill down
into the tree to view the log levels of each package.

The root logging level represents the default log level for all packages that are not
explicitly set. The root level is set to INFO

This field is populated with the name of the selected package when you select a package
in the Package tree.

If the selected package has a log level explicitly set, the value is displayed in the Log
Level field.

Select checkbox to reset the log recursively.

This button puts the settings into effect immediately for all future logs.

This button resets the selected package to the log level of root.
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System Logging - Realtime Tab
This topic describes the features of the System Logging > Realtime tab and the Services Logs view >
Realtime tab.

The Realtime tab is a view of the NetWitness Platform log or a service log. When it is initially loaded,
the view contains the last 10 log entries. As new entries become available, the view is updated with
those entries.

To access the Realtime tab:

1. Goto ADMIN > System.

2. In the options panel, select System Logging.
The System Logging panel opens to the Realtime tab by default.

What do you want to do?

Administrator See details of Log entry Displaying System and Service Logs

Related Topics

System Logging - Settings View

System Logging - Historical Tab
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Quick Look

The following is an example of the Realtime tab in the System Logging panel.

RSA| RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN @admin® ()

System

Info (o

System Logging
Updates h

Realtime | Historical Settings
Licensing

ALL v | Keywords Search
Email

Timestamp Level  Message
Global Notifications

WARN  Host has not received update, resetting Concentrator-New

Legacy Notifications INFO
INFO feed TAXIIProxy.
NFO AXIl data for feed Anomal

Global Auditing

Jobs

Live Services

URL Integration
Context Menu Actions

Investigation

AXIIProxy

ESA

INFO No new TAXII data for feed Anomal

ESA Analytics
Whois
HTTP Proxy Settings

NTP Settings

RS /\ NETWITNESS PLATFORM

Displays System Logging Panel
Displays Realtime Tab
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The following is an example of the Realtime tab in the Services Logs view, which is similar.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE  ADMIN

4 Change Service | 1B Broker

-Broker | logs ©

System Logging
Realtime || Historical
ALL v ||Keywords

Timestamp Level

2017-09-27T11:18:43.000  AUDIT

Broker v | Search
Message
Broker returned 0 from session call because of dead range 11,458,239, 11,458,238
User admin (session 1471833 ) has requested the SDK session info: id1=11458239 id2=11458238

Broker returned 0 from session call because of dead range 11,458,239, 11,458,238

User admin (session 1471745, 1 ) has logged out
Accepring connection from trusted peer i with subject name C = US, ST = VA, L = Reston, O = RSA, OU = NetWitness, CN = adc8bSe6-bbcd-d4ed-b6b0-02971516ebc1
User admin (session 1471882, ) has logged in

User admin has a mismatch for query.timeout in local account and trusted credentials. Using supplied value 5.
User admin has 8 mismatch for session.threshold in locsl account and trusted credentials. Using supplied value 100000.
User admin (session 1471898, hasloggedin

User escalateduser (session 1471916, i) has logged in

RS /\ NETWITNESS  PLATFORM

Features

The Realtime tab has a toolbar with input fields to allow filtering of the entries, and below the toolbar is
a grid containing the log entries.

Toolbar

Description

Log Level drop- Selects the log level for entries to display in the grid. The Log Level drop-down

down

ALL
ALL
TRACE
DEBUG
INFO
WAHN
ERROR
FATAL

shows the available log levels for the system or the service.
- . System logs have seven log levels.

o Service logs have only six log levels because they do not include the TRACE
level.

o The default is ALL log entries.

Keywords field  Specifies a keyword to use when filtering entries. This field is the same for

system and service log filtering.
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Service field Specifies the service type to use when filtering service log entries. Possible

(Service Logs values are the host or the service.

only)

Filter button Click to activate filtering based on the log level, keyword, and service selections.

Log Grid Columns

Timestamp This is the timestamp for the entry.
Level This is the log level for the message.
Message This is the text of the log entry.
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System Logging - Historical Tab

The Historical tab provides a searchable view of the NetWitness Platform log or the service log in a
paged format. When initially loaded, the grid shows the last page of the log entries for the system or the
system.

To access the Historical tab:
1. Goto ADMIN > System.
2. In the options panel, select System Logging.
The System Logging panel opens to the Realtime tab by default.
3. Click the Historical tab.

What do you want to do?

Administrator View the Historical Graph Historical Graph for System Stats

Related Topics

System Logging - Realtime Tab

System Logging - Settings View
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Quick Look

The following is an example of the Historical tab in the System Logging panel. It shows the NetWitness
Platform logs.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN 1;1 @admm- @

nfo Syster oging .
System ,CGUW‘Dr 2
Updates
e Realtime fistorical tings
Licensing
Search # Export
Email

Global Netifications
Legacy Notifications

System | 7‘|‘\=‘_

Global Auditing

Jobs

Live Services

URL Integration
Context Menu Actions
nvestigation

ESA

ESA Analytics

Whois

d for serv

HTTP Proxy Settings

No neve TAXI dat for feed TAXIIProxy -

{ { | Page 200 of200 c

RS /\ NETWITNESS PLATFORM

201
NTP Settings

Displays System Logging Tab
Displays Historical Tab
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The following is an example of the Historical tab in the Services Logs view. It shows the services logs.

RSA RESPOND  INVESTIGATE MONITOR CONFIGURE  ADMIN () admin ©

& Change Service | Il Broker - Broker | Logs

System Logging
Realtime | Historical

Start Date End
Timestamp Level

0 AUD
AUD!
AUDI
0 AUDI
AUDI
AUDI
0 AUD
AUD
AUDI
0 INFO
AUD!
AUD

0 AUD!

AUD!

{ { | Page 200 of 200

2 - 4000 AUDIT

Broker v Search » Export

| has requested the SDK ses:

) has issued query (channel 2=244631880 threshold=0 query="select * where alert=\"lookup and add with packet count and 5 params with ...

T ) has issued que

has issued query (channel 146:

T Useradmin (session 1463572, 1 -~ " """ "7 hasfinished query (channel 1463664, queued 00:00:00, execute 00:

User admin (session 14 has finished query (channel 1463676, queued 00:00:00, executt 631880 threshold=0 query="

T User admin (session 1463642, has finished query (channel 1463687, queued 00:00:00, executt 631880 threshold=0 query="select * where ip.dst e..
T Userad ) has finished query (channel 1463698, queued 00:00:00, execut =244631880 threshold=0 query='
T User admin (session 14 has logged o
Device" consumed session ranges (11
T User admin (session 1463631, ) has logged out
T Userad ) has logged out
T  Userad ) has logged out
T  Userad ) has logged in
User ad: ) has requested the SDK summary info: flags=1 M

| Displaying 9951 - 10000 of 10000

R'S /\ NETWITNESS' PLATFORM

Features

The Historical tab has a toolbar with input fields to allow filtering of the entries, a grid containing the

log entries, an

d paging tools.

Description

Start Date
and End
Date

Log Level
drop-

down

ALL ~
ALL

TRACE
DEBUG
INFO
WARMN
ERROR
FATAL

The Start Date and End Date range search options limit the log entries to a point in
time. When used, you must provide both a start and end date. The times are optional. The

date range is validated to assure that the end date is not before the start date.

Selects the log level for entries to display in the grid. The Log Level drop-down shows
the available log levels for the system or the service.

o System logs have seven log levels.

o Service logs have only six log levels because they do not include the TRACE level.

o The default is ALL log entries.
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Keyword Specifies a keyword to use when filtering entries. This field is the same for system and

field service log filtering.

Service  Specifies the service type to use when filtering service log entries. Possible values are
field the host or the service.
(Service

Logs only)

Search Click to activate a search based on the start and end date, log level, keyword, and service

button selections.

Export  Click to export the currently viewed grid entries to a text file. You can select either

comma-separated or tab-separated format for the entries in the file.

Timestamp This is the timestamp for the entry.
Level This is the log level for the message.
Message This is the text of the log entry.

The paging tools below the grid provide a way to navigate through the pages of log entries.

| Page 1 of16 | )} »IC

Search Log Entries

To search the results shown in the Historical tab:

1. (Optional) Select a Start Date and End Date. Optionally, select a Start Time and End Time.
2. (Optional) For system and service logs, select a Log Level and a Keyword, or both.

3. (Optional) For service logs, select the Service: host or service.

4. Click Search.
The view is refreshed with the most recent 10 entries matching your filter. As new matching log

entries become available, the view is updated to show those entries.
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Show Details of a Log Entry

Each row of the Historical tab Log grid provides the summary information of a log entry. To view
complete details:

1. Double-click a log entry.
The Log Message dialog, which contains the Timestamp, Logger Name, Thread, Level and

Message, is displayed.

Log Message

Timestamp 2017-09-27T09:22:02.505
Logger Name Index

Thread

Level INFO

Message Indexes are being initialized

2. When finished viewing, click Close.

Page Through the Entries
To view the different pages of the grid, use the paging controls on the bottom of the grid as follows:
o Use the navigation buttons

o Manually enter the page you want to view, and press ENTER.

Export

To export the logs in the current view:

Click Export, and select one of the drop-down options, CSV Format or Tab Delimited.

The file is downloaded with a filename that identifies the log type and the field delimiter. For example, a
NetWitness Platform system log exported with comma-separated values is named UAP_log_export_
CSV.txt, and an appliance log exported with tab-separated values is named APPLIANCE_log_export_
TAB.txt.
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